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Warranty

All products manufactured by ICP DAS are under warranty regarding defective
materials for a period of one year, beginning from the date of delivery to the original

purchaser.

Warning

ICP DAS assumes no liability for any damage resulting from the use of this product.
ICP DAS reserves the right to change this manual at any time without notice. The
information furnished by ICP DAS is believed to be accurate and reliable. However, no
responsibility is assumed by ICP DAS for its use, not for any infringements of patents

or other rights of third parties resulting from its use.

Copyright

Copyright @ 2018 by ICP DAS Co., Ltd. All rights are reserved.

Trademark

The names used for identification only may be registered trademarks of their

respective companies.

Contact US
If you have any problem, please feel free to contact us.

You can count on us for quick response.

Email: service@icpdas.com
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1. Introduction

This chapter provides an overview of the WP-5000-CE7 and its components, and introduces the
fundamental concepts for user familiar.

The WP-5000-CE7 includes the following models:
* WP-5231-CE7
e WP-5231M-CE7
* WP-5231PM-3GWA-CE7
* WP-5231PM-4GC-CE7
* WP-5231PM-4GE-CE7

wiTPAR
WP-5231M-CE7

WP-5231M-CE7

il
I

WP-5231PM-3GWA-CE7

WP-5231PM-4GC-CE7 WP-5231PM-4GE-CE7

The WP-5000-CE7 are equipped a Cortex-A8 CPU (1 GHz) and running a windows CE.NET 7.0
operating system. The optional I/O expansion board, XV-board, provides high-protection 1/0.
Using the built-in Flash and microSD, the WP-5000-CE7 can save application program, image file
and data.

The WP-5231PM-3GWA-CE7 is equipped with the 3G module that work on frequencies of WCDMA
2100/1900/900/850 MHz and GSM 850/900/1800/1900 MHz. These modules utilize the 3G
network for convenient and inexpensive data transfer from remote instruments, meters,
computers or control systems in either live data or packet data. These modules has the integrated
TCP/IP stack so that even simple controllers with serial communications ports can be connected to
the modem without the need for special driver implementation. With the features of theirs, the
systems can be SMS and GPRS or 3G connection applications with our PAC.
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1.1. Features

The WP-5000-CE7 offer the most comprehensive configuration and remote system upgrade
solutions to meet specific application requirements. The following list shows the hardware and
software features designed to simplify installation, configuration and application.

» Windows Embedded Compact 7.0

QJ Windows®
K sEmbedded

Compact 7

* Support PC based software: Visual Studio.NET

e Web server, FTP server, Telnet server

» Local I/0 and Communication Expansion Board

WP-5000-CE7 are equipped with an I/O expansion bus to support one optional expansion
board, called XV-board. It can be used to implement various 1/O functions such as DI, DO, A/D,
D/A, Timer/Counter

For more information about these available expansion boards, please refer to

http://www.icpdas.com/root/product/solutions/hmi touch monitor/touchpad/xv-board sel

ection.html

WP-5000-CE7 (WinCE7 Based) Series User Manual version 1.1.2 Page: 7
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Various Memory Expansions

WP-5000-CE7 provides various memory storage options, such as

FRAM and microSD. Customers can choose the memory based on

their characteristics. Adapter

* 64 KB FRAM: no limit on the number of write-erase cycles.

* microSD/microSDHC: to implement portable data logging applications; supports up to 32
GB.

Unique 64-bit Hardware Serial Number to Protect Your
Program

A unique 64-bit serial number is assigned to each hardware
device to protect your software against piracy.

Remote I/0 Module and Expansion Unit

With the built-in RS-485 and Ethernet port, the WP-5000-CE7 can connect RS-485/Ethernet
remote 1/0 units (RU-87Pn/ET-87Pn) or modules (I-7000/M-7000/ET-7000).

Remote 1/0

1
co T @M @ 8
RU-87Pn 1-7000 M-7000
Ethernet —— ﬁ a
ET-87Pn ET-7000
CAN-8000 Series CAN-2000 Series
\ J of \ CAN bus _J m “ m m m’
‘ B ' CAN-8124 CAN-8224 CAN-B424 CAN-2018C CAN-2088C
5000 Series 1 o - .
. I = :
S FRnet m' ( llll
pC Cell Phone i |
FR-2053iT FR-2057iT FR-2054T
WP-5000-CE7 (WinCE7 Based) Series User Manual version 1.1.2 Page: 8

Copyright © 2018 ICP DAS Co., Ltd. All Rights Reserved. E-mail: service@icpdas.com



Plastic and Metal Housing

The WP-5231-CE7 comes with the plastic casing, while the WP-5231M-CE7,
WP-5231PM-3GWA-CE7 and WP-5231PM-4GE-CE7 come with the metal casing.

Highly Reliable Under Harsh Environment

Our WP-5000-CE7 operates in a wide range of temperature and humidity.

* Operating Temperature: -25~ +75 °C

* Storage Temperature: -40 ~ +80 °C
* Humidity: 10% ~ 90% RH, non-condensing

WP-5000-CE7 (WinCE7 Based) Series User Manual version 1.1.2 Page: 9
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1.2. Specifications

The table below summarizes the specifications of the WP-5000-CE7.

1.2.1. WP-5231-CE7 and WP-5231M-CE7

Models

System Software

(0N

WP-5231-CE7

Windows CE 7.0 Professional

WP-5231M-CE7

Framework Support

.Net Compact Framework 3.5

Embedded Service

FTP Server, Web Server

SDK Provided

DIl for Visual Studio.Net 2008

English, German, French, Spanish, Russian, Italian, Korean, Simplified
Multilanguage Support
Chinese, Traditional Chinese

CPU Module

CPU Cortex-A8, 1 GHz
DDR3 SDRAM 512 MB
Flash 256 MB
FRAM 64 KB

microSD socket with one 4 GB microSD card
Expansion Flash Memory
(support up to 32 GB microSDHC card)

RTC (Real Time Clock) Provide second, minute, hour, date, day of week, month, year

64-bit Hardware Serial Number Yes, for software copy protection

Dual Watchdog Timers Yes

Rotary Switch Yes (0 to 9)

LED Indicators 1 LED for Power and Running; 2 LEDs for user defined

WP-5000-CE7 (WinCE7 Based) Series User Manual
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Models WP-5231-CE7 WP-5231M-CE7

VGA & Communication Ports

Resolution 640 x 480, 800 x 480, 800 x 600, 1024 x 768

Ethernet RJ-45 x 1, 10/100/1000 Base-TX
(Auto-negotiating, Auto MDI/MDI-X, LED indicators)

USB 2.0 1

com1 RS-232 (RxD, TxD, and GND); Non-isolated

COM 2 RS-232 (RxD, TxD, and GND); Non-isolated

CcCoOmM 3 RS-485 (Data+, Data-); Non-isolated

COM 4 RS-485 (Data+, Data-); 2500 V¢ isolated

1/0 Expansion

I/0O Expansion Bus Yes, one optional XV-board

Dimensions (W x H x D) 91 mm x 132 mm x 52 mm 117 mm x 126 mm x 58 mm
Housing Plastic Metal
Installation DIN-rail mounting Wall Mounting/DIN-rail mounting

Environmental

Operating Temperature -25°Cto +75°C
Storage Temperature -40°Cto+80°C
Ambient Relative Humidity 10 % to 90 % RH (non-condensing)

Input Range +12 Vpc to +48 V¢
Consumption 4.8W (0.2A @ 24 Vp()
WP-5000-CE7 (WinCE7 Based) Series User Manual version 1.1.2 Page: 11
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1.2.2. WP-5231PM-3GWA-CE7

Models | WP-5231PM-3GWA-CE7

System Software

(0N

Windows CE 7.0 Professional

Framework Support

.Net Compact Framework 3.5

Embedded Service

FTP Server, Web Server

SDK Provided

DIl for Visual Studio.Net 2008

Multilanguage Support

CPU Module

English, German, French, Spanish, Russian, Italian, Korean, Simplified

Chinese, Traditional Chinese

CPU Cortex-A8, 1 GHz
DDR3 SDRAM 512 MB
Flash 256 MB
FRAM 64 KB

Expansion Flash Memory

microSD socket with one 4 GB microSD card

(support up to 32 GB microSDHC card)

RTC (Real Time Clock)

Provide second, minute, hour, date, day of week, month, year

64-bit Hardware Serial Number

Yes, for software copy protection

Dual Watchdog Timers

Yes

Rotary Switch

Yes (0 to 9)

LED Indicators

VGA & Communication Ports

1 LED for Power and Running; 2 LEDs for user defined

Resolution 640 x 480, 800 x 480, 800 x 600, 1024 x 768

Ethernet RJ-45 x 1, 10/100/1000 Base-TX
(Auto-negotiating, Auto MDI/MDI-X, LED indicators)

USB 2.0 1

comM1 Console Reserved for OS

COM 2 RS-232 (RxD, TxD, and GND); Non-isolated

cComM3 RS-485 (Data+, Data-); Non-isolated

COM 4 RS-485 (Data+, Data-); 2500 Vp¢ isolated

WP-5000-CE7 (WinCE7 Based) Series User Manual
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Models

1/0 Expansion

I/0 Expansion Bus

Dimensions (W x Hx D)

WP-5231PM-3GWA-CE7

Yes, one optional XV-board

117 mm x 126 mm x 58 mm

Housing

Metal

Installation

Environmental

Operating Temperature

Wall Mounting/DIN-rail mounting

-25°Cto +75°C

Storage Temperature

-40°Cto+80°C

Ambient Relative Humidity

Input Range

10 % to 90 % RH (non-condensing)

+12 Vpc to +48 Ve

Consumption
GSM System

Frequency Band

6.5W

GSM: 850/900/1800/1900 MHz

GPRS Connectivity

GPRS class 12/10; GPRS station class B

Data GPRS
3G System

Frequency Band

Downlink transfer: Max. 85.6 kbps; Uplink transfer: Max 42.8k bps

WCDMA 850/900/1900/2100 MHz

Data Transmission

GPS System (option)

Downlink transfer: Max. 85.6 kbps; Uplink transfer: Max 42.8k bps

Support Channels 32
Protocol Support NMEA 0183
WP-5000-CE7 (WinCE7 Based) Series User Manual version 1.1.2 Page: 13
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1.2.3. WP-5231PM-4GC-CE7 and WP-5231PM-4GE-CE7

Models

System Software

(0N

WP-5231PM-4GC-CE7 WP-5231PM-4GE-CE7

Windows CE 7.0 Professional

Framework Support

.Net Compact Framework 3.5

Embedded Service

FTP Server, Web Server

SDK Provided

DIl for Visual Studio.Net 2008

Multilanguage Support

CPU Module

English, German, French, Spanish, Russian, Italian, Korean, Simplified

Chinese, Traditional Chinese

CPU Cortex-A8, 1 GHz
DDR3 SDRAM 512 MB
Flash 256 MB
FRAM 64 KB

Expansion Flash Memory

microSD socket with one 4 GB microSD card

(support up to 32 GB microSDHC card)

RTC (Real Time Clock)

Provide second, minute, hour, date, day of week, month, year

64-bit Hardware Serial Number

Yes, for software copy protection

Dual Watchdog Timers

Yes

Rotary Switch

Yes (0 to 9)

LED Indicators

VGA & Communication Ports

1 LED for Power and Running; 2 LEDs for user defined

Resolution 640 x 480, 800 x 480, 800 x 600, 1024 x 768

Ethernet RJ-45 x 1, 10/100/1000 Base-TX
(Auto-negotiating, Auto MDI/MDI-X, LED indicators)

USB 2.0 1

comM1 Console Reserved for OS

COM 2 RS-232 (RxD, TxD, and GND); Non-isolated

cComM3 RS-485 (Data+, Data-); Non-isolated

COM 4 RS-485 (Data+, Data-); 2500 Vp¢ isolated
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Models

1/0 Expansion

I/0 Expansion Bus

Dimensions (W x Hx D)

WP-5231PM-4GC-CE7 WP-5231PM-4GE-CE7

Yes, one optional XV-board

117 mm x 126 mm x 58 mm

Housing

Metal

Installation

Environmental

Operating Temperature

Wall Mounting/DIN-rail mounting

-25°Cto +75°C

Storage Temperature

-40°Cto+80°C

Ambient Relative Humidity

Input Range

10 % to 90 % RH (non-condensing)

+12 Vpc to +48 Ve

Consumption
GSM System

Frequency Band

6.5W

GSM: 850/900/1800/1900 MHz

GPRS Connectivity

GPRS class 12/10; GPRS station class B

Data GPRS

Frequency Band

Downlink transfer: Max. 85.6 kbps; Uplink transfer: Max 42.8k bps

WCDMA 900/2100
TD-SCDMA 1900/2100
CDMA2000 (BCO0) 800

WCDMA 850/900/2100 MHz

Data Transmission

Frequency Band

DC-HSPA+ Download: Max. 42 Mbps; Upload: Max 5.76Mbps

TD-SCDMA Download: Max. 4.2 Mbps; Upload: Max 2.2Mbps
CDMA2000 EVDO Download: Max. 14.7 Mbps; Upload: Max 5.4Mbps

FDD LTE: B1/B3/B8
TDD LTE: B38/B39/B40/B41

FDD LTE: B1/B3/B5/B7/B8/B20

Data Transmission

Download Max 100Mbps/Upload Max 50Mbps

GPS System (option)

Support Channels 32
Protocol Support NMEA 0183
WP-5000-CE7 (WinCE7 Based) Series User Manual version 1.1.2 Page: 15
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1.3. Overview

The WP-5000-CE7 is equipped with several interfaces and peripherals that can be integrated with
external systems. Here is an overview of the components and its descriptions. The details of these
items are as follows:

Front View

Item I Description
LED Indicators The WP-5000-CE7 series modules has 3/4 LED indicators shown as below.
WP-5231-CE7 WP-5231M-CE7

WP-5231PM-4GE-CE7

LED Indicator Color Meaning

3G/4G Green The 3G/4G LED indicates that the antenna is

connected to 3G/4G network.

RUN/PWR Green Power is on
Orange Power on and OS is running
L1 Orange
User programmable LED indicator.
L2 Orange
WP-5000-CE7 (WinCE7 Based) Series User Manual version 1.1.2 Page: 16
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Top View

XV-board Slot

VGA Port
microSD Socket

SIM Card Socket
Antenna Connector x 2

Item Description

XV-board Slot The XV-board slot can be used to support up to one XV-board service.

VGA port A VGA connector is a 3-row 15-pin connector that can be used with a
variety of supported VGA resolutions, and the output resolution
covers 640x480, 800x480, 800x600, 1024x768.

microSD Slot The microSD slot can be used to restore the WP-5000-CE7 system and
expand the memory up to 32 GB.

SIM Card Socket (for WP-5231PM-3GWA-CE7/WP-5231PM-4GE-CE7 only)

TheWP-5231PM-3GWA-CE7/WP-5231PM-4GE-CE7 has a SIM card
socket that supports 3G/4G network.

Antenna Connector (for WP-5231PM-3GWA-CE7/WP-5231PM-4GE-CE7 only)

TheWP-5231PM-3GWA-CE7/WP-5231PM-4GE-CE7 has 2/1 antenna
connector(s) that can be used to connect the antenna.
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Bottom View

Rotary Switch

LAN Port

— USB 2.0 Port
COM4 LOM3 COM2 oML DC CoM4 COM3. CoM2 Resery DC
r“ar™ "ot [Tal 1011
24 5:2388888¢8¢rk s38.538¢8,  §8rE

)

(o o

Item Description
LAN Port The WP-5000-CE7 has an Ethernet port that can be Link/Act 100MAG
connected to a computer or device via an Ethernet
cable.
The Link/Act and 100M/1G LED indicators display the
status of the WP-5000-CE7. The details are shown as below.
LED Indicator State (Color) Meaning
ON (Orange) Network Speed: 1 G
100M/1G
OFF Network Speed: 10/100 M
ON (Green) The Link is active
Link/Act OFF The Link is inactive
Blinking(Green) Network activity
USB 2.0 Port The WP-5000-CE7 has an USB 2.0 port that allows support for the USB
devices such as mouse, keyboard or an external USB hard drive.
Rotary Switch Rotary Switch is an operating mode selector switch which
provides seven functions related to the selection of the
operating mode.
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Item Description

WP-5231-CE7/
WP-5231M-CE7
Signal Description ‘
Pin Assignment
Frame Ground
P.GND
Power Input
PWR
TXD
RXD COM 1: RS-232
GND
TXD
RXD COM 2: RS-232
GND
D+
COM 3: RS-485
D-
ISO.GND
D+ COM 4: RS-485
D-
WP-5231PM-3GWA-CE7/
WP-5231PM-4GC-CE7/
WP-5231PM-4GE-CE7 ‘ Signal Description \
Pin Assignment F.G Frame Ground
P.GND
Power Input
PWR
TXD
RXD Reserved
GND
TXD
RXD COM 2: RS-232
GND
D+
COM 3: RS-485
D-
ISO.GND
D+ COM 4: RS-485
D-
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COM1 (3-wire RS-232)

(for WP-5231-CE7 and WP-5231M-CE7 only)

Note: 16C550 compatible

Baud Rate: 115200, 57600, 38400, 19200, 9600, 4800, 2400, 1200 bps
Data Bits: 5, 6, 7, 8

Parity: None, Even, Odd, Mark (Always 1), Space (Always 0)

Stop Bits: 1, 2

FIFO: 64 bytes

COM2 (3-wire RS-232)

Note: 16C550 compatible

Baud Rate: 115200, 57600, 38400, 19200, 9600, 4800, 2400, 1200 bps
Data Bits: 5,6, 7, 8

Parity: None, Even, Odd, Mark (Always 1), Space (Always 0)

Stop Bits: 1, 2

FIFO: 64 bytes

COMS3 (2-wire RS-485)
Note: 16C550 compatible

Baud Rate: 115200, 57600, 38400, 19200, 9600, 4800, 2400, 1200 bps

Data Bits: 5,6, 7, 8

Parity: None, Even, Odd, Mark (Always 1), Space (Always 0)

Stop Bits: 1, 2

FIFO: 64 bytes

COM4 (2-wire RS-485)

Note: 16C550 compatible

Baud Rate: 115200, 57600, 38400, 19200, 9600, 4800, 2400, 1200 bps
Data Bits: 5, 6, 7, 8

Parity: None, Even, Odd, Mark (Always 1), Space (Always 0)

Stop Bits: 1, 2

FIFO: 64 bytes
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1.4. Dimensions

The diagrams below provide the dimensions of the WP-5000-CE7 to use in defining your enclosure
specifications. Remember to leave room for potential expansion if you are using other

components in your system. All dimensions are in millimeters.

WP-5231-CE7
—— 520 —- 910

3 )

389 E:.: X
11350 E

35.6

* 123.0

38.9
1]

T T

Left Side View Front View
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WP-5231M-CE7, WP-5231PM-3GWA-CE7, WP-5231-4GC-CE7and WP-5231-4GE-CE7

- 1170 ——— =
~— 58.0 — = —~—— 1016
e ® ]
O
I %
| R 28.5
71.0 A {}
113.0 @4 5
126.0 A ©0060
! 14.0
—O O
L,j ooooooooooooool
Left Side View Front View
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1.5. Companion CD

This package comes with a CD that provides a collection of the software utility, documentation,
drivers, demo program and application. The CD contains several subdirectories located in
\WP-5231-CE7 directory. All of them are listed below.

CD:\wp-5231\

Backup

i

The files package for each release.

”E

The demo programs for examples of use in the application.

The technical support documents for installation, operation,

maintenance, development and application.

I

The files stored on micro_SD card, that can be used to boot and
recover the system from micro SD card.

OS_image

|

The files and related information for OS releases and technology.

I

The tools and utilies for operation with PC.

|

The sources for development and application in your application.

I

The tools and drivers related to System_Disk that install on WP-5000-CE7.

Update

|

The installation packages related to WP-5000-CE7.
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2. Getting Started

This chapter provides a guided tour of the WP-5000-CE7 installation and configuration that
describes the steps needed to download, install, configure, and run the basic procedures for user
working with the WP-5000-CE7 for the first time.

Before starting any task, please check the package contents. If any of the following package

contents are missing or damaged, contact your dealer, distributor.

WP-5231-CE7

;

WP-5231-CE7/WP-5231M-CE7
WP-5231PM-3GWA-CE7/WP-5231PM-4GC-CE7
o /WP-5231PM-4GE-CE7

A

= e /
WP-5000-CE7 A microSD card and Screzw Driver
Quick Start Guide a micro SD/SD adapter Software Utility CD (1C016) 2.4 mm

The following items are DIN-rail mounting kit included with WP-5231M-CE7,
WP-5231PM-3GWA-CE7, WP-5231PM-4GC-CE7 and WP-5231PM-4GE-CE7 only

44 mm DIN-Rail Clip M3x6L Screw * 4 Pin Terminal * 16

The following items are included with WP-5231PM-3GWA-CE7, WP-5231PM-4GC-CE7and
WP-5231PM-4GE-CE7 only

GSM/GPRS External GPS Active External
Antenna (ANT-421-04) Antenna (ANT-115-03)
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2.1. Mounting the Hardware

By hardware mechanism, the WP-5000-CE7 installation guide is divided into two sections, as
follows:

1. For WP-5231-CE7 — section 2.1.1. WP-5231-CE7 Installation

2. For WP-5231PM-3GWA-CE7 — section 2.1.2. WP-5231PM-3GWA-CE7 Installation
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2.1.1. WP-5231-CE7 Installation

Here is a brief of the steps to install the WP-5231-CE7.

2.1.1.1. Installing the WP-5231-CE7

The WP-5231-CE7 has simple rail clips for mounting reliably on a standard 35 mm DIN rail.

Step 1: Mounting WP-5231-CE7 onto a 35 mm DIN rail

Remove the WP-5231-CE7 from the DIN rail
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Step 2: Connecting to a PC, the USB device, and the power supply

i. Connect the mouse or keyboard to the USB port.

ii. Connect PC to the Ethernet port through an Ethernet switch.

iii. Connect the power supply (+12 to +48 VDC) to PWR and P.GND terminals.
iv. Connect the monitor to the VGA port.

Power Supply
+12 to +48 Vpc

Monitor
USB Mouse or USB Keyboard
Ethemnet Switch PC or Laptop
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2.1.1.2. Installing the XV-Board

WP-5231-CE7 has one expansion 1/0 slots to expand the functions. For more detailed information
about the XV-board specifications, please refer to Appendix B. XV-Board Modules.

Step 1: Remove stripped screws and then

remove the cover

Step 2: Hold the XV-board vertically and align the
socket, and then carefully press the XV-board
onto the socket
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Step 3: Close the cover and then fasten the screws

Step 4: Insert the 1/0 terminal and then stick the 1/0 sticker

§B8888

XVIT1/XVITIA

0000000
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2.1.2. WP-5231M-CE7/WP-5231PM-3GWA-CE7/WP-5231PM-4GC-CE7/
WP-5231PM-4GE-CE7 Installation

Here is a brief of the steps to install the
WP-5231M-CE7/WP-5231PM-3GWA-CE7/WP-5231PM-4GC-CE7/WP-5231PM-4GE-CE7.

2.1.2.1. Installing the WinPAC

The WP-5231M-CE7/WP-5231PM-3GWA-CE7/WP-5231PM-4GC-CE7/WP-5231PM-4GE-CE7 can be

mounted either directly to a wall/panel.

Step 1: Install the four mounting screws into the 4 keyhole mounting holes

Tips & Warnings

A Recommended screw for mounting is M4 x 12L.

Step 2: Fasten the screws securely
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Step 3: Connecting to a PC, the USB device, and the
power supply

i. Connect the mouse or keyboard to the USB port.

ii. Connect PC to the Ethernet port through an Ethernet switch.

iii. Connect the power supply (+12 to +48 VDC) to PWR and P.GND terminals.
iv. Connect the monitor to the VGA port.

Power Supply
+12 to +48 VDC

e \VVGA Port

Monitor USE Port
LAN Port

USB Mouse/USB Keyboard

Ethernet Switch PC or Laptop
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2.1.2.2. Inserting the SIM card

(for WP-5231PM-3GWA-CE7, WP-5231PM-4GC-CE7 and WP-5231PM-4GE-CE7
only)

The SIM card tray is located on the top side of the module. The eject button is on the right side of
the tray door.

SIM Card Socket

Eject button

Step 1: Push the ejection button until the SIM card tray

pops out

Step 2: Pull out the tray completely and set it on a flat surface

Step 3: Put the SIM card in the tray, and then push the tray back into the socket

Tips & Warnings

Q Make sure to turn the WP-5231PM-3GWA-CE7/WP-5231PM-4GE-CE7 off before
inserting or removing the SIM card. Do not bend or scratch the SIM card.
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2.1.2.3. Installing the antenna

(for WP-5231PM-3GWA-CE7, WP-5231PM-4GC-CE7 and WP-5231PM-4GE-CE7
only)

The WP-5231PM-3GWA-CE7/WP-5231PM-4GE-CE7 has 2/1 antenna connectors that can be used
to connect the 3G antenna. To install the antenna, just screw the antenna tightly into the
connector, and put the antenna in the purpose place.
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2.2. Configuring the Boot Mode

The WP-5000-CE7 has several operating modes, which can be selected by a rotary switch.

The table below lists the operation modes available with the WP-5000-CE7.

Position Operating Mode

0 Normal mode (Default)

1 Safe mode

2 Debug mode

3 OS update mode by Ethernet

4 Reserve

5 OS update mode by Micro_SD

6 Reserve (OS Development Mode)
7~9 User Mode

The following is a brief introduction of these modes.

Normal Mode (Default mode)

Normal mode is the default mode of operation and the one you will use most of the time. Use this
mode for more tasks and configurations. Programs also are executed in this mode.
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Safe Mode

Safe mode is a trouble shooting. The mode loads the minimum required device drivers and system
services to boot the WP-5000-CE7.

If you have malicious software or a program caused the WP-5000-CE7 cannot be boot or run the
normal mode, you can boot in safe mode to solve the problem.

Debug Mode

Debug mode is a special environment in which program debug functions can be used in addition to
normal system functions.

Debug mode is unsupported.

OS Update Mode

OS update mode is a way used to update OS. For more information on updating the WP-5000-CE7

OS image, please refer to section 6.1. OS updates

Reserve — OS Development Mode

The positions 4, 6, of rotary switch are reserved for OS development.

User Mode

The positions 7, 8, 9 of rotary switch are reserved for user’s applications.

When WP-5000-CE7 is boot with one of these positions, it is boot at normal mode. User’s

application can check the position of the rotary switch position to run at different mode.
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2.3. Using PAC Utility to Manage WinPAC

The PAC Utility is a collection of the WinPAC system tool that allows user quickly and easily
manage and configure the WinPAC.

For more detailed information on PAC Utility applications, please refer to “3.1. PAC Utility”

Step 1: Double-click the PAC Utility on the desktop

Step 2: Configure IP address (DHCP), FTP Server, Auto
Iﬁf/ Execution files..., etc

Double-click the
PAC Utility shortcut

e e ]

File Help
[General I General2 I Display I IF Config ‘ Tework |Dewce Information IAum Execution I Rotary Exd 1 I 2
Access | Login
FTP @Enable (O Disable

Allow Anonymous @ Enable (O Disable

Set FTP default download directory to:

[ [ by |
vty Device
Metwork
SetHTTP do| . System _disk
"wvindowsw| Recycled Apply
-#pplication Data
Iy Recent Docurments
-My Documents
Program Files
=
Windows
Cancel | Ok
Step 3: Reboot the WP-5000-CE7
Restore Utility Default Settings
Exit
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2.4. Using DCON Utility Pro to Configure I/O Modules

DCON Utility Pro enables users easily to configure and manage the 1/0 modules via Ethernet or
serial ports (RS-232/RS-485).

Step 1: Double-click the DCON_Utility_Pro on the desktop

il

F

Double-click the
DCON_Utility Pro
shortcut

Step 2: Click the button

@awrmtility Pro 2.0.0.0%or CE7 arm({WP5231)

ar L ~ddress EI End Address |1

I |Addr... |Baud Rate |Check5... |Format|5tatu5 |De5criptior1
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Step 3: Configure the communication settings

COM Port Option

COM Port Timeout
COMO[Backplare] | |2DD ‘ ms
COM1 |
COM3 Q l
I
oM 2 OES81 00,381
OK Cancel

Tips & Warnings

Q The COM port settings for expansion I/O modules are listed below.

COMO[Backplane] <€

I
Pl
A g
0y —
W fag
N
“ g
3
-~
-
i3
$
3
3
g
|

comi/2/3/a <
For more information on these COM port selections, please refer to the

specification of the pin assignments in section 1.3. Overview
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Step 4: Click the E button

Eart AosTiis El End Address 1

D IAddr‘.. IBaud Rate IChecksH. IFormatlStatus IDescription

4]

Step 5: Click the module name to configure the 1/0 module

DCON Utility Pro 2.0.0.0 for CE7 arm{WP5231)

Start Address [0 | End Address

I lAddr... |Baud Rate |Check5... |Format|5tatus |De5criptiom
X107 ) B 115200  Disable  N,3,1 [Modbus RTUS*DI + 8%0

XV107 Firmware[0100]

DO Status

[Jo [ [J2 [J3 [J4 [Js [Js [J7

Set Power On | @ Read DO
K I () Read Power OM Yalue

Set Safe Vale | (") Read Safe value

[
COM:O[N,8
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2.5. Changing the User Interface Language

The Windows CE operating system on the WP-5000-CE7 comes with several built-in functions.

Step 1: Click Start menu, point to Settings, click Control Panel, and then click Regional Settings

Options

Jj Prograrns ’
i:‘? Faviorites r
D Documents
- Settings

B Contral Panel
"i;-, Metwork and Dial-up Connections
E‘ Taskbar and Start Men...

iR ¥

gictial
Settings

Regional and Language Settings

Regional Settings

Lser Interface Language I Input Language |

-Your locale

The locale option affects how some programs format numbers, currency,
time and dates,

Customize...
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Step 2: Click User Interface Language tab, choose to your local language, and then click OK

Regional and Language Settings m

| Regional Settings | User Interface Language | Input Language |
-User Interface Language

The option will determine the language used for the menus, dialogs
and alerts,

EI

French (
German (Germarny)

Italian (Ttaly)

Portuguese (Brazil)

Spanish (Spain - International Sort)

Step 3: Run the PAC Utility, and then reboot the WinPAC for changes to take effect

= |

Reboot
E[/- Restore Utiity Default Settings
HPAC TTtilit... Exit
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2.6. Using Dial-up Networking to Make a GPRS Connection

(for WP-5231PM-3GWA-CE7, WP-5231PM-4GC-CE7 and WP-5231PM-4GE-CE7
only)

The Windows CE dial-up networking component driver can be efficiently used to include support
for transferring data over GPRS modems in WP-5000-CE7

Step 1: Click Start menu, point to Settings, click Network and Dial up Connections, and then click

Make New Connection

_v_,_,.._/_\/'n ’\-w\,-\‘_/\'_,-nw’\

7, TN,

s ™y
@Efwm > . “Cry 2 .
¢ Favorites  » v Ak 2,
) Documents *

(¥ control Panel

D gun.. 2 Q}_ : 1
S T

FETCESB1  FETCESBZ

_onnection

#1 Px
. Lea A
PCI- PCL- {;

»

Wmﬁ"‘v\ﬂ

Step 2: Type the name of the connection, select the Connection type as the Dialup connection,

and then click Next button

Make New Connection
Type a name for the connection:

el
_‘-.-:@I_ IM\; Connection

Select the connection type:
(@) Dial-Up Connection
() Direct Connection
{7 Wirtual Private Metwork (PPTR)
() virtual Private MNetwork (L2TP)
() PPR aver Ethernet [PPPoE]

| < Back |_
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Step 3: Select USB Modem as a modem diver in the select a modem option and then click
Configure button

My Connection Properties

Moderm l Phone Number |

7]y Connection
e

Select a modern:

Configure...

TCPJIP Settings... | Security Settings... |

Step 4: Select 115200 in the Baud Rate option and click then click OK button

Device Properties m
Part Settings lca" Options |

cannection Preferences ——

Manual Dial (user supplies dial =
[] B ey Baud Rate 15200
. Lava Tits
Terminals
r Use terminal window Parity
hefore dialing Stop its
u Lise terminal window after
dialing Flowe Cortral Hardware -

Step 5: Select Call Options tab, enter the modem dialing settings in the commands field, and
then click OK button

The modem dialing settings depends on each of the telecom company. For example,
the settings provided by Telecom Company in Taiwan is

+CGDCONT=1,"”IP”,”INTERNET”
and a Telecom Company in China is

+CGDCONT=1,"IP”,”CMNET”

Device Properties m
Part Settings l

Call Setup
[w| Cancel the call if not connected within - [120  seconds
[w Wait for dial tone before dialing

Wait for credit card tone |0 seconds

Extra Sztungs (special rmodemn cornrmands may be inserted into the gzl string)
|+CGDCONT= 1,"TP","INTERNET"
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Step 6: Select Phone Number tab, enter the phone number settings in the Phone number option,
and then click OK button

The phone number settings should fit the Telecom Company’s setting. For example,
the following setting is for Telecom Company in Taiwan.

My Connection Properties m

Phane Murmber

Jj}l My Connection

Countryfregion code: |1

Area code: !*‘. 27
Phone number: |*99***1#

[] Force long distance
[] Force local

Step 7: Double-click the new connection that you have created, and enter the User name and
Password, and then Click Connect button

File Edit View  Advanced || X |6 |2,

7 =) =] 3
Bl ¥\ %
Make Mew My LaMZ Lam1

Connectign  Connection

Dial-Up Connection
-
= :l [y Connection
“l=s
Uszer Mame: |guest F{'u:une: HQokAk ]
Passward: | s
BrEmmEre | \; \[ Dial Properties.,, |
[ Save password | Connect I : Cancel |
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Step 8: Wait for the connection to be established

U200 Status
Jj}l Connected

Hide this rnessage:

Disconnect

Tips & Warnings

If the connection fails, as shown below, please repeat the instructions to view the
settings.

Remote Networking

;
i ! E The port is not availlable: another program may be using it.
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3. Tools and Tasks

This chapter provides a brief introduction of the WP-5000-CE7 service tools and its benefits.

There are several tools and utilities built-in and designed for use with WP-5000-CE7. Some of
these are pre-installed on WP-5000-CE7 and can work directly on WP-5000-CE7, and some of
these are supporting tools and can help you to manage the WP-5000-CE7 remotely on a PC.

The following tools are pre-installed on WP-5000-CE7 and can work directly on WP-5000-CE7 that
can be found on the CD that was provided with the package or by downloading the latest version
from ICP DAS web site.

CD:\wp-5231\System_Disk\Tools\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/system_disk/tools/

- T
B oo maste-too
T
— T
— T
oot Doy
- T
T
T
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The following tools are supporting tools for remote managing the WP-5000-CE7 used on PC that
can be found on the CD that was provided with the package or by downloading the latest version
from ICP DAS web site.

CD:\wp-5231\PC_Tools\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/pc_tools/

Eshell

Remote_display_application

Tl Tools

Vcep
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3.1. PAC Utility

PAC Utility is a collection of software applications that enable management and configuration of
WinPAC system and features.

PAC Utility [1.2.0.5] ! E

GEHEFE”' Cisplay I IF Config I Metwark I Cevice Information I.-’-\ub:u Execution IRDtary Execution |

Welcame o use PAC Utility
This tool will help vou easy to
Lse P&C CE series.

PAC Utility

Task Bar setting:
[ duto Hide
[ &lways On Top

HIVE Registry:
@ Auto Save To Flash (Default)

— (C) Maunal Save To Flash

Backplane Battery [[] Enable sutorun in plugging USE Disk
Batheryl . Bathery2
Configure the synchronization with a time server | Configure

The PAC Utility includes the following menu bars and property tabs. All of these functions will be
explained later.

Menu bar Property Tab

> File General
» Help General2
Display
IP Config
Network
Device Information

Auto Execution

vV VV VY V¥V VY Vv Y

Rotary Execution
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3.1.1. Menu Bar - File

Save
Save and Reboot

The menus use to How to use

Reboot Restarts the WinPAC
Restore Default Settings Restore the settings of WinPAC to its default.
Exit Exits the PAC Utility.
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3.1.2. Menu Bar - Help

About PAC Utility

PAC Utility
Yersion: 1.2.0.5

Copy Right () 2005, ICPDAS Co., LTD.
All Rights Reserved, PAC Utility and the
PAC Utility logos are rademarks of
ICPDAS,

PaC Qwindows CE; en-US)

The menus use to How to use

About Displays a dialog box with information about PAC Utility,
including the current version and copyright information.
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3.1.3. Property Tab - General

The General tab provides functions to configure the task bar, check the status of the battery..., etc.

PAC Utility [1.2.0.6]

File Help

- General | Display IIF' Config INetWDrk IDevice Information Iﬁub:u Execution IRDtary Execution |

Welcome to use PAC Litility
This tool will help you easy o
Lise PAC CE series.

PAC Utility

Task Bar setting:
[ swuto Hide

[ slways On Top

HIVE Registry:

'@ Auto Save To Flash (Default)

O Maunal Save To Flash
Backplane Battery [] Enable &utarun in plugging USE Disk
Batteryl . [] Enable sutarun in plugging Micra S0
Caonfigure the synchronization with a time server | Configure |

The tab use to How to use

Lock or Auto-Hide the taskbar Auto-Hide:

Select the Auto Hide check box.
Lock:

Select the Always On Top check box.

Auto save or manual save to By default, these options are unavailable.
flash Auto save to flash:
This option is checked by default.
Any changes made to the WP-5000-CE7 will be saved
and only take effect after the WP-5000-CE7 reboots.
Manual save to flash:

This option is useless.

Check the status of the battery See the Battery1 field that displays the display resolution.

Automatic synchronization of Refer to the Appendix A.2. How to Automatically
system time Synchronize WinPAC Clock with an Internet Time Server.
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3.1.4. Property Tab — Display

The Display tab provides functions to configure the monitor settings.

PAC Utility [1.2.0.6] ! E

Gereral | Display | IF Canfig I Metwork I Device Information I Ao Execution I Rotary Execution |

Screen resolution: 800 % 600 Screen refresh rate:
Less G MMore 70 EI

800 by 600 pixels

The tab use to How to use

) Move the slider to the left to decrease the resolution or move the
Adjust the screen . ) ) ) )
) slider to the right to increase the resolution, and then click the
resolution
Apply button.
Change the screen Select the desired refresh rate from the Screen refresh rate
refresh rate drop-down list, and then click the Apply button.
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3.1.5. Property Tab — IP Config

The IP Config tab provides functions to configure either DHCP (Roaming) or manually configured
(Static) network settings and to monitor the MAC address. Generally, DHCP is the default settings,
but if you don’t have a DHCP server, you must configure the network settings by using manual
configuration.

PAC Utility [1.2.0.6]

File Help

LAN 1:

MAC Address: F3-C5-E5-823-95-8C
@ Use DHCP to get IP address

() Assign IP address

IF Address: |1E|,1,|:|,8E|

Mask: |255.255.D.EI

|
|
Gateway:  [10.1,0.254 |
|

OMS Server: |1EI.III.III.3

["] Reboot for changes to take effective

Use DHCP to get IP address:

Select the Use DHCP to get IP address option, and then click the
Set the network Apply button.
settings Assign an IP address:
Select the Assign IP address option, and then click the Apply
button.
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3.1.6. Property Tab — Network

The Network tab comprises three tabs — Access, Login and File Server Settings.

Access

The Access tab provides functions to enable/disable the FTP access, enable/disable anonymous
FTP access, and configure the FTP and HTTP directory path.

PAC Utility [1.2.0.6] ! E

[General Display IIF' Config | Network | Device Information IAub:u Execution IRDtarﬁ,r Execution |

EﬁEEESS Logiry I File Server Settings |

FTP (W Enahle () Disahle

Allow Anonymous @ Enable (O Disable

Set FTF default download directory to;
\Temp || | | Apply

Set HTTF document root directory to:

Yvindowesiwrienoraraesb || || Apply

Enable:
Select the Enable check box in the FTP field, and then click the
Enable or disable the Apply button.
FTP access Disable:
Select the Disable check box in the FTP field, and then click the

Apply button.
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The tab use to How to use

Enable:

) Select the Enable check box in the Allow Anonymous field, and

Enable or disable )
then click the Apply button.

Disable:

Select the Disable check box in the Allow Anonymous field, and

anonymous FTP
access

then click the Apply button.

Set the FTP directory | Enter a new path in the Set FTP default download directory to: field,

path and then click the Apply button.
Set the HTTP Enter a new path in the Set HTTP document root directory to: field,
directory path and then click the Apply button.

Login

The Login tab provides functions to maintain the FTP accounts.

PAC Utility [1.2.0.6] M [=]

[General IDispIay IIF' Config | Metwork | Device Information Iﬁub:u Execution I Rotary Execution |

Access | Login | File Server Settings |

User Name Password

licrDas | e | Add | Delets
Liser narme I Password I]
ICPDAS ok

The tab use to How to use
Maintain the FTP Refer to the Appendix C.1 How to add a user account to remote
accounts login the WinPAC from PC.
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File Server Settings

The File Server Settings tab provides functions to set the SMB server.

eneral ] Display ] IF Config | Metwork lDevice Information ] Auto Execution ] Rotary Execution ]

ACCess l Login | File Server Settings l

client devices and other shared eguipment,

fou can create a networked file server and enables clients o store and
retrieve files, and makes use of the Internet for communication between

- Seftings ‘
Share Files System Settings ! *

Device Mame (Each device need setting
a different device name)

|C|:| rpact |

The path to the folder to be shared

|1Temp | |

Configure the file server to use Lalx as
the network adapter

|cPewact -]

Enzble all authentication on the file
server, The file server will not be
accessible o all users on the

v network and the "admin" as the
user o be allowed access to the
file server
Set
Help
Set the SMB server Click the Settings button to set the SMB server path.
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3.1.7. Property Tab — Device Information

The Device Information tab provides functions to monitor necessary system information of the
WinPAC. The information is the most important note of version control for upgrading system.

PAC Utility [1.2.0.6]

General ] Display ] IP Config ] Netwaork | Device Informatian l AL Execution | Rotary Execution \

Slett: [ ] CPU Type: [wPs23: |
Slat 2: |:| Serial Number : |p1-s8-2c-1F-16-00-0020 |
Slat 3 I:I Backplane Version: |fo-1 |
Slat 4 I:I CPU YYersion: |Nﬁ-‘« |
Slot 5 I:I 0S Yersion: |1|:||:|5 |
Slat 6: I:I Eboot Yersion: |5,2,5,25 |
Slot 7. I:I MNET CF Yersion: |3,5,?338.|:||:| |

SQL CE version: [a5.81540 |

PACSDK Yersion: [4321 |
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3.1.8. Property Tab — Auto Execution

The Auto Execution tab provides functions to configure programs running at WinPAC startup, it

allows users to configure ten execute files at most.

Tips & Warnings

The specific extensions are .exe and .bat, and they are executed in order of program 1,
program 2, etc.

PAC Utility [1.2.0.6]

[General IDISpIay IIF' Config I Metwork IDevice Information | AUt Execution |R|:|tar3.r Execution |

Frogram 1 |‘-EH,fstem_Disk\Tu:u:uIsWn:epw_remn:ute.exe || Browse |

Program 2: |Eystem_Disk\Tu:u:.|s\PAc_Uti|itnyAc_Uti|ity. || Browse |

Prograrm 3. | | | Browse |
Program 4: | | Browss |
At most 10 prograrms  Frogram 3 | Browse |

can be specified to

execute automatically P 2 = 2 | | | EEEE I
at system startup. Frogram 7. | | | Browse I
Prograrm 8: | | | Browse |
Prograrm 9: | | | Browse I
Frograml0: | | Browse |
Configure programs Click the Browse button to select the execute file which you want,
running at startup and then click the Apply button.
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3.1.9. Property Tab — Rotary Execution

The Rotary Execution tab provides functions to configure programs running at WinPAC startup in
one of the user defined mode, it allows users to configure ten execute files at most.

PAC Utility [1.2.0.6] M [=]

[ zeneral IDispIay I IP Config I Metwark I Device Information I Auto Execution | Rotary Execution |
Ratary Switch O |Ngrma| Mode | | Brovwyse I
Rotary Switch 1. |Saﬁg Maode | | Browse |
Rotary Switch 2:  [Debug Mode | [erowss_]
Rotary Switch 3: |OS update mode by Ethernet | | Browse |
Rotary Switch 4: |Reserued | | Browse |
Rotary Switch 5 |OS update made by Micra_SD | | Erowse |
Rotary Switch 6. |Reserued | | Browse |
Rotary Switch 7: | | . Browse |
Rotary Switch 8: | | Browse |
Rotary Switch 3. | | . Browse |

The tab use to How to use

Configure programs running at ) . .
) Click the Browse button to select the execute file which
startup in one of the user .
] you want, and then click the Apply button.
defined mode
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3.2. DCON Utility Pro

DCON Utility Pro enables users easily to configure and manage the I/0 modules via Ethernet or
serial ports (RS-232/RS-485).

For more detailed information on how to use DCON Utility Pro to configure I/O modules, please
refer to “2.4. Using DCON Utility Pro to Configure I/O Modules”

DCON Utility Pro 2.0.0.0 for CEF arm{WP5231)

Start Address EI End Address

D |ﬁ~ddr... |Baud Rate IChecks... |Format|5tatus |De5cription
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3.3. TaskMgr

The TaskMgr is a Windows CE application, which provides real time info on all processes and

threads including System threads, similar in appearance to the Windows Task Manager.

Windows CE Task Manager
Perfonmance IPrt:u:esses Iﬂpp]icatiu 1 u

100%:

Usage 2%

Processes

windows CE Task Manager

Lpplicatio II u

[rnage Mam...

| Threa... | Ilern.

Fs

TaskIvlanager.e
w_rernote exe
servicesd.exe
explorer.exe
CrarelTser exe
ndevice exe

ndeice exe
WE BEYE

4]

Windows CE Task Manager

Processes

&pplications | Disk | Het| 4] ¥

Task

Y Virtual CE

Cloze

Switch
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3.4. VCEP

ICPDAS VCEP is designed for managing your WinPAC anywhere. No matter where you are, ICPDAS
VCEP provides a convenient environment on the Desktop PC and lets you control your WinPAC

remotely.

ICPDAS VCEP is composed of two main components: The “Server” which runs on WinPAC and the
‘Client” which runs on a Desktop PC.

Once a connection is established between the client and server (initiated by the client), the client
will periodically send requests for screen updates and send mouse/key click information to the
server to simulate.

Each video frame is inter-compressed against the previous frame and then intra-compressed with
a modified LZW scheme to minimize the amount of data transmitted from server to client.

For more detailed information on VCEP application, please refer to

http://ftp.icpdas.com.tw/pub/cd/winpac/napdos/wp-8x4x ce50/pc tools/vcep 5.0.0.0/
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3.5. Remote_Display

The "Remote Display" allows WinPAC to be controlled and monitored from a remote location. This
tool is composed of two parts, a client and a server. The server is a program named cerdisp.exe
running on WinPAC. The client is a PC-based program named cerhost.exe running on the PC.
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3.6. SendToCOM

The SendToCOM uses the serial port to communicate with expansion module. To use the
SendToCOM, you can send data to expansion module through the serial port, and receive data
from other device through the serial port.

For more information about these commands for communicating with expansion module, please
refer to:

http://www.icpdas.com/root/product/solutions/remote io/rs-485/i-8k i-87k/i-8k i-87k selection
.html#b

ICPDAS Send to COM V1.0.4 2011/2/23
Connection Status
COM Port Baudrate Data Bik Parity: Stop Bit Slak
|cor~12 ~] |1152|:u:| B4 |a :I ||:|-None Paity :| |1 :| | :|
Endstringwith @ Nore (OLF.cR (YR (JCRAF (LF [string | 4 +cre
Bi String | Send Pallin
Commands Responses O ey @ nd
Current Packet Size (bytesh |p Current Packet Size (bytes) g Auta send Internal {ms)  |snn
Total Packet Bytes 1] Total Packet Bytes 1] | Start | | Stop | Set
Packet Quantity send a Packet Quantity received |0 Start Time |Start Time
ﬂl Skop Time  [Stop Time
r FS
- -
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3.7. RegEdit

The RegEdit provides a hierarchical representation of the registry on a target computer, similar in
appearance to the Windows Registry Editor. The standard registry roots are represented; you can
add keys beneath a root to point to existing registry keys, or you can add your own keys. Values
can be changed for existing keys, or added for new keys, and default keys can be specified. For

more information, see Registry Settings Management in Deployment.

EaRH Mame I Type I Data I
B HKE
-- HEEY_LOCAL_MACHIME
e HKEY_USERS
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3.8. 1SQLW35

The "ISQLW35" is a Windows Embedded Compact 7 functionality that implements SQL Server
Compact 3.5 Query.

’E’; Objects

soL | 3 arid Mates

..... k. a5

Tools SOL | 6 W X
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3.9. INotepad

The INotepad is a common text-only editor. The resulting files have no format tags or styles.

INotepad ! E
File Edit Format Help

| -
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4. Your First WinPAC Program

This chapter provides a guided tour that describes the steps needed to set-up a development
environment, download, install, configure for user programming with the WP-5000-CE7 series

modules.

Before writing your first program, ensure that you have the necessary development tool and the

corresponding WinPAC SDKs are installed on your system.

Development Tools

WP-5000-CE7 series modules are Windows CE-based units. Windows CE is a mature embedded

operating system which supports rapid development.

The table below lists the supported development tools and development languages to develop
WP-5000-CE7 applications.

Languages Visual . -
Visual C# Visual C++

Development Tools Basic.Net

Any versions except

Visual Studio Professional )

2005 or earlier
Professional - - -

Any versions except

Visual Studio Professional . - -
2008
Professional v U v
Any versions except
Visual Studio - - -

Professional

2012 or later
Professional - - -
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4.1. Preparing the Development Tools

WP-5000-CE7 is a Windows CE-based unit. Windows CE is a mature embedded operating system
which supports rapid development. The standard development tool is list as follows which is highly
integrated, with comprehensive support for developing applications of Windows CE-based
WP-5000-CE7.

>  Visual Studio 2008

Micrgsoft' ‘

Visual Studio 2008

WP-5000-CE7 has .NET Compact Framework 3.5 installed. Visual Studio 2008 takes full
advantage of the .NET Compact Framework, which uses public Internet standards to enable
integration with new and existing applications running on any platform. Supported languages
include Visual C#, Visual C++ and Visual Basic .NET.

Installation Steps:

1. Visual Studio 2008 Professional
Purchase from MSDN subscription
Microsoft DreamSpark: https://www.dreamspark.com/Product/Product.aspx?productid=1

2. Visual Studio 2008 Service Pack 1
http://www.microsoft.com/en-us/download/details.aspx?id=10986

3. Visual Studio 2008 update for Windows Embedded Compact 7
http://www.microsoft.com/en-us/download/confirmation.aspx?id=11935

4. Windows Embedded Compact 7 ATL Update for Visual Studio 2008 SP1
http://support.microsoft.com/kb/2468183/en-us
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4.2. Installing WP-5000-CE7 SDK

The WiIinPAC SDK is a Software Development Kit (SDK) that contains C header files, C libraries and
documents.

Step 1: Insert the CD into your CD-ROM drive

Step 2: Execute the “AM335x_WINCE7_SDK_YYYYMMDD.msi”

The AM335x_WinCE7_SDK_YYMMDD.msi can be obtained from:
CD:\wp-5231\SDK\PlatformSDK\

The installation program for the latest version of the WinPAC Platform SDKs can be
obtained from:

http://ftp.icpdas.com/pub/cd/winpac am335x/wp-5231/sdk/platformsdk/

File name: am335x_wince7_sdk_yyyymmdd.msi
yyyymmdd: platform sdk released date

Step 3: Follow the prompts until the installation is complete

Step 4: Execute the “VisualStudioDeviceWindowsEmbeddedCompact7.msi”

The VisualStudioDeviceWindowsEmbeddedCompact7.msi can be obtained from:
CD:\wp-5231\SDK\PlatformSDK\

http://ftp.icpdas.com/pub/cd/winpac am335x/wp-5231/sdk/platformsdk/
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Step 5: Execute any VS2008 C++ project include the AM335x_WINCE7_SDK(ARMv4l) platform
and the click the “Tools”->"Options...”

Toolz | Test Wmdow Help
;-‘A Attach o Process... Ctl+AlH4P

@z | Device Secunty Manager..

EJ;. Comnect to Dewice. ..

G| Device Emulator Manager. ..

"""_J;. Connect to Databaze. .

‘g Connect fo Berver. ..

) Code Snippets Manager..  CtlK, Ctll+B
Chooss Toolboy Items. ..

Add-in Manager. ..

Macmoz 3

Find More Extensdons...

Create GUID
Dotfuzeator Commnndty Edition
Error Lookup

A TLFC Trace Tool

Bt

Wisual Stodio 2005 Commeand Frompt
=B WCF Service Contignratinn Editor

External Tools...

Linport and Export Sethings..

I‘-Ln-g-{vjmion )

Cptions. .
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Step 6: Click the “Projects and Solutions”->"VC++ Directories” and then select the
“AM335x_WINCE7_SDK (ARMv4I)” ~ “Include files” at “Platform:” and “Show

directories for:” item

Ophons E] )

+- Erviromment Tlatform: Show directories for:
= Projects and Solutions AW 335 WINCE? SDE (AEMy % | | Inclode files w
Creneral
Bnild and Eun
B Defanlts
WC++ Directories ¥ CInstallDir)ce Pinclude
W C++ Project Settings SV CInstallDivhee Phatlmfc\includ e
- Soee Contol OV CInstall Dirhcetdnelud e
 Texd Editor CAProgram Files\Windows CE ToolsSDERAM 230 WINCET_SDE\nclud eht
Datshase Tools C\Program Files\Windows CE Tools'\SDESLM335: WINCET_SDE\nclude
- Lalahes Loo FVClnstallDivheebatlmfcinclud e
+- Debugging Ve InstallDin S mantDeviced SDEIQL Servertobilels 2.0
+- Device Tools
+- HTML Designer
+- Office Tools
+- Test Tools < >
gi- ot Tempiatng Include Directories
*+ 0w PoLE LeRgler Path to vse when ssarching for include files while building a VC++ project.
+)- Workflow Designer Corresponds 1o enviromment variable INCLUDE.

[ ok || Cancel |

Step 7: Add the path “S(VCinstallDir)ce7\include” and “$(VClinstallDir)ce7\atimfc\include” and
then click the OK button.

EIATOLL: N0 ATRCTOTES TOT;
Ab 335 WINCEY _EDE (ARM » | | Include files L
7] x|+ 4]
$(VC InstallDirice Tinclode
IV CIngtallDiv)ce Patlmtc\inende
B IVC Install Divheehinelod e

CAProgram Files\Windows CE TooldSDESAM 3350 WINCET _SDE\nclodeht
CAProgram Files\Windows CE Tools#SDESMMM 335 WINCE? _SDE\nclude
IV CIngallDincetatlmfciinelude

BV aTnstal 1D S martDeyiceSDEASQL ServerMobile'w 3.0

Tips & Warnings

e The path “S(VClnstallDir)ce7\include” and “S(VClnstallDir)ce7\atimfc\include” must
be on the top of box.
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4.3. First WinPAC Program in VB.NET

The best way to learn programming with WinPAC is to actually create a WinPAC program.

The example below demonstrates how to create a demo program running on WinPAC with
VB.NET.

To create a demo program with VB.NET that includes the following main steps:

1. Create a new project

2. Specify the path of the PAC reference
3. Add the control to the form

4. Add the event handling for the control
5. Upload the application to WinPAC

6. Execute the application on WinPAC

All main steps will be described in the following subsection.

In this tutorial, we will assume that you have installed WP-5000-CE7 SDK on PC and used the Visual
Studio 2008 for application development.
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4.3.1. Create a New Project

The Visual VB.net project template is a composite control that you use in this example creates a
new project with this user control.

Step 1: Run the Visual Studio 2008

Visual Studio 2008

2

Step 2: On the File menu, point to New, and then click Project

File | Edit View Tools Test Window Help

New » | 5] Project. Cirl+Shift+N

Open P @ WebSite... Shift+ A1+ N

Close (] Eie.. Chl+N
Project From Existing Code...

G Save ALl Ctl+Shaft+S

Recent Files 2
Recent Projects »
Exit
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Step 3: In the Project types pane, expand Visual Basic, and then click Smart Device
Step 4: In the Templates pane, click Smart Device

Step 5: Type a name in the Name field, and then click OK

Here we will enter the name “SDKInformation” and a different location for the project if

you wish

New Project @

Project tipes: Tk HET Framework 3.5 v || EH

= Visual Basic Yisual Studio installed templates

Tl ind oes (v

Web ‘JE Smart Device Project

Smart Device )

Office

Datsbase My Templates

Reporting

Test

WCF

Workflow
Vimal C#
Vimal C++
Other Project Types
Test Frojects

i Sesach Onling Templates...

.A _praject for Smart Device applications. Choose target platform, Framework version, and templ&te in the next dialog box.

Hame: DK Informatinn |
Location: CADocuments and Sethngsh W ind owsby Docoments Wi Windowsd My Documents v
Solution Name: SDEInfommation Create divectory for solution

[ oK || Concel |

Tips & Warnings

A The WCE7 only support .NET Compact Framework Version 3.5, if your application
uses .NET Compact Framework Version 2.0 there is no guarantee that the program

will function correctly.
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Step 6: In the Target platform item, choose Windows CE

Step 7: in the .NET Compact Formwork version item, choose .NET Compact Framework Version
3.5

Step 8: in the Templates pane, choose Device Application, and then click Next

Add New Smart Device Project - SDEInformation

Target platform: | Windows CE b |
NET Compact Framework version: | NET Compact Framework Verdon 3.5 il |
Templates:
& M ¥ = o=
LEVRY Description:

Device Clazs Library Console Control — Empty Project 4 project for creating a NET
A pplication A pplication Library Cu:upmp]ant meﬂngl?iig 35 S
application for Windows CE
Flatform

Diownload additonal emulator images and smart device STEs.

OK || Cancel
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4.3.2. Specify the Path of PAC Reference

The PAC SDK provides a complete solution to integrate with WP-5000-CE7 and it's compatible with
Visual C#, Visual Basic .net and C++. In order to use a component in your application, you must
first add a reference to it.

Stepl: Get the PACNET.dIl and copy it to the project folder

The PACNET.dIl can be obtained from the link below that has been provided on the CD or
by downloading the latest version from ICP DAS web site.

CD:\wp-5231\SDK\PACNET\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/sdk/pacnet/

PACHET.dlL
22 0.7.24401
PALCHET
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http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/sdk/pacnet/

Step 2: In Solution Explorer, right-click the References node, and then click Add Reference...

Zolotion Explorer - MyPorject

2 2F EHEH

_J Soluton MyPonect' (1 project)

= e =

Febuild

Deploy

Clean

Add 2

4dd Reference.,

Add Web Feference,,,
&, Wiew Class Disgram

Set oz Stardllp Project

Debug 4
& Cuf

/X Remoye
Fenagme
Tiload Project

[1  Open Folder in Windows Explorer
Change Target Platform. ..

'_:='; Properties

'@Remm‘ce View 'g-g aolution Explorer :,% Clazs View
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Step 3: Select Browse tab and add the PACNET.dII

Add Reference

| NET | Projects I Browss IRecent |
Loeation: | (5 SDKInformation VI o 2 E®E-
) bin
() My Project
(=obj
EYPACNET.AL!
Hame: PACNET.AN |
File types: ICOmpon.ent Files (*d1;* tlb;* olb;* ocx;* exe) V‘
[ ok || Cawel |
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4.3.3. Add the Control to the Form

You can drag various controls from the Toolbox onto the form. These controls are not really "live";
they are just images that are convenient to move around on the form into a precise location.

After you add a control to your form, you can use the Properties window to set its properties, such
as background color and default text. The values that you specify in the Properties window are the
initial values that will be assigned to that property when the control is created at run time.

Step 1: From the Toolbox, drag a Button control onto the form

Toolbox
=/ All Device Controls
R Pointer

227 BindingSource

l Button

CheckBox
=% ComboBox SDKInformation* ' Forml.vb [Design]* ~ Start Page ¥ X

FE| Contexthenu
1 DataGrid

29| DataSet

77 Date TimePicker
[ DomainUpDown

<> HicrollBar
=) ImageList v
fgvlrl E]-Cpl[ll‘i‘.l';},:_ Toolbox [ . . v
= mainMenul
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Step 2: Right-click the Button control, and then click Properties

SDKInformation* ' Forml.vb [Design]*  Start Page

bt

qd
X

g Buttonl
(m,

[Z] View Code

{4; Bring to Front
4% Send to Back

& Lock Controls
Select Forml'
Cut

Copy

W o

L

< | % | Delete >

= mainMenul ' Properties

Step 3: In the Properties window, type Check the SDK version, and press ENTER to set the Text

property
Buttonl System. Windows Forms Button -
31 [E] #
= Tant A
BackColor [] Control
Font Tahoma, 10pt
ForeColor - ControlText
Check the SDK Version v,
=) i
ContextMenu (none) 7
Text
The text contained in the control.

[#2 Class View | j}l’roperties [

T ds:
v
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4.3.4. Add the Event Handling for the Control

You have finished the design stage of your application and are at the point when you can start
adding some code to provide the program's functionality.

Step 1: Double-click the button on the form

SDKInformation* = Forml.vb [Design]*
fomi W

Q, .................................... [ causesesesesssesssesssesssassnsist ‘
0 Check the SDK Version

d
X

= mainMennl
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Step 2: Inserting the following code

Dim data(30) As Byte
PACNET.Sys.GetSDKVersion(data)
MessageBox.Show(PACNET.MISC.WideString(data))

mPublic Class Forml

Private Sub Buttonl _Click(BvVal sender fs Svztem.Object, BwVal e Az System.Eventdrgs) Handles Buttonl.Click
Dim data(30) b=z Byte
PACNET Bvstem GetiDEVerzion(data)
WezsageBox  Show(PACNET MISC WideString(data))
End Hub
End Claszs

Tips & Warnings

A The “PACNET” of “using PACNET” is case- sensitive.
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4.3.5. Upload the Application to WinPAC

WinPAC supports FTP server service. You can upload files to WinPAC or download files from a

public FTP server.

— 40—

RELSELAR 0 0,0 00, 0 000 0 2 20 )

Step 1: On the Build menu, click Build SDKInformation

File Edit Yiew Project [Build | Debug Tools Test Window Help

=5 DBuild Solution Ctrl+Shift+B
Rebuild Solution
Deploy Solution
Clean Solution

[%¥) Build SDKInformation
Rebuild SDKInformation
Deploy SDKInformation
Clean SDKInformation
Project Only b
Batch Build...
Configuration Manager...

2 Compile Ctl+F7
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Step 2: Open the browser and type the IP address of WinPAC

Step 3: Upload the SDKinformation.exe application and the corresponding PACSDK.dIl and
PACNET.dII files to WinPAC

Tips & Warnings

For applications programming in C# and VB.net with .net compact framework, when
A executing these application on WinPAC, the corresponding PACSDK.dIl and PACNET.dII
must be in the same directory as the .exe file.

File Edit View Go Favorites |||]][

[I]Address | YTemp

IID

PACHET.dl  PACSDE, dll i
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4.3.6. Execute the Application on WinPAC

After uploading the application to WinPAC, you can just double-click it on WinPAC to execute it.

]

EDKInformati:
ooneRe
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4.4. First WinPAC Program in Visual C#

The best way to learn programming with WinPAC is to actually create a WinPAC program.

The example below demonstrates how to create a demo program running on WinPAC with C#.
To create a demo program with C# that includes the following main steps:

1. Create a new project

2. Specify the path of the PAC reference

3. Add the control to the form

4. Add the event handling for the control

5. Upload the application to WinPAC

6. Execute the application on WinPAC

All main steps will be described in the following subsection.
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4.4.1. Create a New Project

The CH project template is a composite control that you use in this example creates a new project
with this user control.

Step 1: Run the Visual Studio 2008

Visual Studio 2008

&

Step 2: On the File menu, point to New, and then click Project

File | Edit View Tools Test Window Help

New » | 5] Project.. Cirl+Shift+N

Open » | @ WebSite.. Shift+ Alt+N

Close ] FEie.. Chl+N
Project From Existing Code...

@ Save Al Ctl+Shaft+S

Recent Files »
Recent Projects >
Exit
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Step 3: In the Project types pane, expand Visual C#, and then click Smart Device

Step 4: In the Templates pane, click Smart Device

Step 5: Type a name in the Name field, and then click OK

Here we will enter the name “SDKInformation” and a different location for the project if
you wish.

New Project

=
Fioject types: Templates: NET Framework 3.5 w | (3 E“

Visual Basic Yisual Studio installed templates
= Visual C#
Windaws ;Esm Device Project
Weh
Smart Device
Office iy Termolates
Diatabasze
Reporting
Text
WCF
Woarkflow
Visval C++
Cither Project Twpes
Test Projects

il Search Online Templates...

-

|P. project for Smeart Device applications. Chooss terget platfiorm, Framework verson, sud template in the next dislog box. |

Name: | SDKInformation |
Location: | CADocuments and SettingsWindouwsibdy Docoment W _Windowsd My Documents “ | Browss. .
Solution Nams: | SDKInformstion | [#]Create directory for solution
[ 0K ][ Cameel |
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Step 6: In the Target platform item, choose Windows CE

Step 7: in the .NET Compact Formwork version item, choose .NET Compact Framework Version
3.5

Step 8: in the Templates pane, choose Device Application, and then click Next

Add New Smart Device Froject - SDEInformation

Target platform: | Windows CE b |
MNET Compact Framework version: | NET Compact Framework Version 3.5 v
Templates:
7 # @ oo
&l = = Dezscription:
- Device Control  Empty Project & project for creating a NET
o Library Compact Framework 3.5 forms
application for Windows CE
Flatfonm

Download additonal emlator imases and smart deviee SDKS. .

0K [ Comeal

Tips & Warnings

A The WCE7 only support .NET Compact Framework Version 3.5, if your application
uses .NET Compact Framework Version 2.0 there is no guarantee that the program

will function correctly.
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4.4.2. Specify the Path of PAC Reference

The PAC SDK provides a complete solution to integrate with WP-5000-CE7 and it's compatible with
Visual C#, Visual Basic .net and C++. In order to use a component in your application, you must
first add a reference to it.

Stepl: Get the PACNET.dIl and copy it to the project folder

The PACNET.dIl can be obtained from the link below that has been provided on the CD or
by downloading the latest version from ICP DAS web site.

CD:\wp-5231\SDK\PACNET\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/sdk/pacnet/

TACNET ALl
i (0.7 24491
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Step 2: In Solution Explorer, right-click the References node, and then click Add Reference...

Solution Explorer - SDKInformation

@ eFE EE&

" (5 Solution SDKInformation’ (1 project)
ERRUI SDK Info mi
@ 4 Proper] (%Y Buid

# - (=g Refere Rebuild

= =] Forml
%) Fo Deploy
¥ Fo Clean
] Pro
_] o Add »
Add Reference...

Add Web Reference...
&, View Class Diagram

Set as StartUp Project

Debug >
& Cut

=

X Remove
Rename
Unload Project

y  OpenFolder in Windows Explorer
Change Target Platform...

Properties

BJ

;) Resource View ;gSoluﬁon Explorer @@ Class View |
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Step 3: Select Browse tab and add the PACNET.dII

Add Reference

| NET | Projects I Browss IRecent |
Loeation: | (5 SDKInformation VI o 2 E®E-
) bin
() My Project
() obi
EYPACNET.AL!
Hame: PACNET.AN |
File types: ICOmpon.ent Files (*d1;* tlb;* olb;* ocx;* exe) V‘
[ ok || Cawel |
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4.4.3. Add the Control to the Form

You can drag various controls from the Toolbox onto the form. These controls are not really "live";
they are just images that are convenient to move around on the form into a precise location.

After you add a control to your form, you can use the Properties window to set its properties, such
as background color and default text. The values that you specify in the Properties window are the

initial values that will be assigned to that property when the control is created at run time.

Step 1: From the Toolbox, drag a Button control onto the form

Toolbox
= All Device Controls
R Pointer

227 BindingSource

l Button

CheckBox

E‘? ComboBox Forml1.cs [Design]*  Start Page | Object Browser v X
FE| Contexthenu e
] DataGrid

29| DataSet

77 Date TimePicker
[ DomainUpDown

<3 HScrollBar
=) ImageList - !
g Server Explorer |4 Toolbox [ - >
.‘"5’-"-“1'-"31 Xplorer w}': ‘
= mainMenul
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Step 2: Right-click the Button control, and then click Properties

Forml .cs [Design]*  StartPage | Object Browser v X

Yiew Code

*4; Bring to Front
44 Send to Back

@ Lock Controls
Select Forml'
Cut

Copy

B %

X (i

Delete
< S Properties >

= mainMenul

Step 3: In the Properties window, type Check the SDK version, and press ENTER to set the Text
property

Buttonl System. Windows Forms Button -
21 [5]
=] Tance ~
BackColor [] Control
Font Tahoma, 10pt
ForeColor - ControlText
Check the SDK Version v,
=) i
ContextMenu (none) 7
Text
The text contained in the control.
'_73 Class View ijErtmﬁ [
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4.4.4. Add the Event Handling for the Control

You have finished the design stage of your application and are at the point when you can start
adding some code to provide the program's functionality.

Step 1: Double-click the button on the form

Forml .cs [Design]* - Start Page s X
N
v
< >
= mainMenul
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Step 2: Inserting the following code

byte []data = new byte[30];
PACNET.Sys.GetSDKVersion(data);
MessageBox.Show(PACNET.MISC.WideString(data));

mnamespace SIEInformation

{
é public partial class Forml - Form

{l
5| public Forml()
{
InitializeComponenty );
- 1
Ll private woid buttonl_Click{object szender, Eventirzz e)
{
byte []data = new bywte[30];
PACNET Bve GetilEVersion(datald;
MezzageBox Show{ PACNET _MIEC _Wideftring(data));
- 1
- i
o
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4.4.5. Upload the Application to WinPAC

WinPAC supports FTP server service. You can upload files to WinPAC or download files from a

public FTP server.

— 40—

RELSELAR 0 0,0 00, 0 000 0 2 20 )

Step 1: On the Build menu, click Build SDKInformation

File Edit Yiew Project [Build | Debug Tools Test Window Help

=5 DBuild Solution Ctri+Shift+B
Rebuild Solution
Deploy Solution
Clean Solution

[%¥] Build SDKInformation
Rebuild SDKInformation
Deploy SDKInformation
Clean SDKInformation
Project Only >
Batch Budd...
Configuration Manager...

% Compile Ctl+F7
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Step 2: Open the browser and type the IP address of WinPAC

Step 3: Upload the SDKinformation.exe application and the corresponding PACSDK.dIl and
PACNET.dII files to WinPAC

Tips & Warnings

For applications programming in C# and VB.net with .net compact framework, when
A executing these application on WinPAC, the corresponding PACSDK.dIl and PACNET.dII
must be in the same directory as the .exe file.

File Edit View Go Favorites |||]][

[I]Address | YTemp

IID

PACHET.dl  PACSDE, dll i
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4.4.6. Execute the Application on WinPAC

After uploading the application to WinPAC, you can just double-click it on WinPAC to execute it.

]

EDKInformati:
ooneRe
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4.5. First WinPAC Program in Visual C++

The best way to learn programming with WinPAC is to actually create a WinPAC program.

The example below demonstrates how to create a demo program running on WinPAC with Visual
C++

To create a demo program with Visual C++ that includes the following main steps:

1. Create a new project

2. Configure the platform

3. Specify the path of the PAC reference
4. Add the control to the form

5. Add the event handling for the control
6. Upload the application to WinPAC

7. Execute the application on WinPAC

All main steps will be described in the following subsection.

Tips & Warnings

A Before beginning a new project, the “Embedded Compact 7 ATL Update” must be
installed. If this update is not installed, the error message “atlconv.h error C2039:
IstrlenW" will be displayed after the program is compiled.

The update can be found on the CD that was provided with the package or by

downloading the latest version from Microsoft.
CD:\wp-5231\SDK\VisualStudioDeviceWindowsEmbeddedCompact7.msi

http://download.microsoft.com/download/9/D/D/9DDBD3EC-A43C-4BCE-A7A9-AEE9
B1007BCE/VisualStudioDeviceWindowsEmbeddedCompact7.msi
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4.5.1. Create a New Project

The Visual C++ project template is a composite control that you use in this example creates a new

project with this user control.

Step 1: Run the Visual Studio 2008

Visual Studio 2008

2

Step 2: On the File menu, point to New, and then click Project

&2 Start Page - Microsoft Visual Studio (Administrator)
Edit View Tools Test Window Help

New » ] Project. Ctrl+Shift+N

Open » | '@ | Web Site.. Shift+Alt+N
[ Close J | File.. Ctrl+N

Close Solution Project From Existing Code..

1

Save Selected Items  Cirl+!

Save Selected Items As..
i@ | Save All Ctrl+Shift+S

Export Template...

Page Setup..
Print.. Ctrl+P
Recent Files b
Recent Projects »
Exit
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Step 3: In the Project types pane, expand Visual C++, and then click Smart Device

Step 4: In the Templates pane, click MFC Smart Device Application

Step 5: Type a name in the Name field, and then click OK

Here we will enter the name “SDKInformation” and a different location for the project if

you wish
New Project » 9 L l EIE
Project types: Templates: NET Framework 3.5 = Hl
a Visual C++ Visual Studio installed templates
ATL EATL Smart Device Project #MFC Smart Device ActiveX Control
CLR @MFC Smart Device Application sf& MFC Smart Device DLL
qu;:r;:eral =E|Win32 Smart Device Project
Smart Device My Templates
Test .l Search Online Templates...
Win32
» Other Languages
» Other Project Types

» Test Projects

An application for Windows Mobile and other Windows CE-based devices that uses the Microsoft Foundation Class Library

MName: SDKInformation
Location: C\Users\Administrator\Documents\Visual Studio 2008\Projects -
Solution Name: SDKInformation Create directory for solution
OK } l Cancel l
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Step 6: On the first page of the wizard, click Next

MFC Smart Device Application Wizard - SDKInformation gmw

-

M Welcome to the MFC Smart Device Application Wizard
F
Overview These are the current project settings:
Platforms ® Windows Mobile 5.0 Pocket PC SDK Platform

® Single document interface
Application Type

Document Template Strings Click Finish from any window to accept the current settings.

User Interface Features After you create the project, see the project's readme.td file for information about the project features
and files that are generated.

Advanced Features

Generated Classes

Pre :_5[ Next = H Finish H Cancel ]

Step 7: On the next page of the wizard, select AM335x_WINCE7_SDK to be added to the project,
and then click Next

-

X

MFC Smart Device Application Wizard - SDKInformation

—=== Platforms

Overview Select platform SDKs to be added to the current project.
Platforms
Application Type

Document Template Strings

Installed SDKs: Selected SDKs:
User Interface Features Windows Mobile 5.0 Pocket PC SDk AM335x WINCE7_SDK
Pocket PC 2003 z
Advanced Features Smartphone 2003
Generated Classes Windows Mobile 5.0 Smartphone 5

A

<«

AM335x_ WINCE7_SDK
(Instruction sets: ARMw4l

<Prewous][ Next = ][ Finish ][ Cancel
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Step 8: On the next page of the wizard, select Dialog based, and then click next

MFC Smart Device ﬁﬁglication Wizard - SDKInformatiol

Application Type

(o ecn [ |

Overview Application type: Use of MFC:

Platforms © single document

Application Type @) Dialog based

Document Template 5trings ) Single document with DocList

User Interface Features e

Advanced Features
Resource language:

=3 (=0)

Generated Classes

O Use MFC in a shared DLL
@ Use MFC in a static library

<Prewous” Next = ]I Finish H Cancel

Step 9: On the next page of the wizard, click next

User Interface Features

-
MFC Smart Device Application Wizard - SDKInformation ;@gw

Overview
Platforms

Application Type

User Interface Features
Advanced Features

Generated Classes

Command bar:
@) Menus only

Menus and buttons

Document Template Strings

Dialog title:
SDKInformation

<Previous|[ MNext = H Finish H Cancel
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Step 10: On the next page of the wizard, click next

-

MFC Smart Device AEEllcation Wizard - SDKInformatiol

Advanced Features

Advanced features:

Overview

Platforms Windows Help

Application Type Printing and print previev

Document Template Strings [ ActiveX controls

User Interface Features L] Windows sockets
Advanced Features
Number of files on recent file list:
Generated Classes
4 |w

lﬂg}

<Pre~.fious][ Mext > ][ Finish ][ Cancel

Step 11: On the next page of the wizard, click Finish
(A**

-

MFC Smart Device Aﬁﬂl]cation Wizard - SDKInformatio

Generated Classes

Generated classes:

Overview
CSDKInformationApp
CSDKInformationDlg

Platforms
Application Type

Document Template Strings

User Interface Features

Class name:
Advanced Features CSDKInformationApp
Generated Classes
Base class:
CWinApp W

lﬁg}

h file:

SDKInformation.h

cpp file:
SDKInformation.cpp

< Previous Next =
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4.5.2. Configure the Platform

When developing applications by using Visual C++, you must configure the Platform to indicate
what platform and device you intend to download the application to. Before you deploy your
project, check the platform.

On the Debug configuration toolbar, select Release, and then on the Pocket PC 2003 (ARMV4)
configuration toolbar, select AM335x_WINCE7_SDK(ARMv4I), as shown in the following
illustration.

b Debug ~ AM335x WINCE7 S ~
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4.5.3. Specify the Path of PACSDK library and header files

The PAC SDK provides the PACSDK library and header files with WP-5000-CE7.

It’s compatible with C++. In order to use a component in your application, you must first add a

reference to it.

Step 1: Right-click the project name, and then click Properties

Solution Explorer - SDKInformation

- [ res

NEET
‘_a Solution RDKInformation' (1 project)

ERNE2| SDK Information

=] ReadMe.bat
h] Resource h
h] Resourceppe.h
¢+ SDKInformatioy
7] SDKInformation
23 SDKInformation
¢+ SDKInformatioy
7] SDKInformation
3 SDKInformatioy
3 SDKInformatioy
¢+ stdafx.cpp
] stdafich

Rebuild
Deploy
Clean
Project Only

Custom Build Rules. ..

Tool Build Oxder...
Add

References...

View Class Diagram
Set as StartUp Project
Debug

Cut

Remove
Rename

Unload Project

Open Folder in Windows Explorer

Properties
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Step 2: In left pane, expand Configuration Properties, and then click Link

Step 3: In the right pane, choose the PACSDK_CE.lib in the Additional Dependencies item

SDEInformation Property Fages

Configuration: |Activeﬂ:lebug) | Platform: |PaC1iV8(XP&CSDK_CE (B0 hd | [ Configuration Manager... ]
Common Properties Additional Dependencies PACSDK lib [Z]
= Configuration Froperties Ignore A1l Default Libraries ¥o

Genel Ienore Speciic Lib
Debugsi gnore Specific Liboary
Dreployment Maodule Definition File
CiC+t Ldd Module o Asmembly
= Linker .
R Embed Managed Remumne File
Tnput Farce Symbol Refersnces
Manifest File Deelay Loaded DLL=
Debugging bmmmbly Link Resoce
Sstem
Optimization
Eribedded DL
Advanced
Command Line
Remurces
HML Document Generator
Browse Information
Build Events
Custom Build Step
Authenticode Signing
Additional Dependencies
Specifies additional items 1o add 1o the link line {ex; kemels2 Lib); configuration specific.
[ = || ®m# |
WP-5000-CE7 (WinCE7 Based) Series User Manual version 1.1.2 Page: 109

Copyright © 2018 ICP DAS Co., Ltd. All Rights Reserved. E-mail: service@icpdas.com



Step 4: In the right pane, choose the following path in the “Additional Include Directories” item

C:\Program Files\Windows CE Tools\SDKs\N2000_WINCE7_SDK\Include\X86
C:\Program Files\Microsoft Visual Studio 9.0\VC\ce7\atImfc\include

testErr Froperty Pages EI E'

Configuration: | ActiveDebug) % | Plafform: | ActiveN2000_WINCET_SDE (x56)) v

Comrnon Properties =C:\Program Files\Windows CE Took\SDKs\HQDU[@
= Configuration Properties
Greneral
Debugzing

Resolve #using References

Diebug Information Format Program Database {{Zi)
Deeployment Suppress Startup Bamner Yes (fologa)

= CiC++ Warning Level Level 3 (JW3)

Greneral .
Opfimization Dietect 64-bit Partability [=mes No
Preprocessor Treat Wamnmngs Az Ermors No
Code Generation

Language
Precompiled Headers
Crutput Files
Brows: Informetion
Advanced
Command Line
= Linker
(remeral
Input
Manifest File
Debngging
Swstern
COptirnization
Ermbedded IDL
Advanced
Commeand Line
Eesources
EML Document Generator
Browse Information
Build Events
Custom Build Step Additional Include Directories

Authenticode Signing %ﬁgﬂtj‘e]s)om or more directories 1o add to the nclude path; vse smi-colon delimited List if more than one.
3

R
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4.5.4. Add the Control to the Form

You can drag various controls from the Toolbox onto the form. These controls are not really "live";
they are just images that are convenient to move around on the form into a precise location.

After you add a control to your form, you can use the Properties window to set its properties, such
as background color and default text. The values that you specify in the Properties window are the

initial values that will be assigned to that property when the control is created at run time.

Step 1: In Resource View, expand the resources tree by opening the top level folder

Step 2: Open the Dialog folder and then double-click the dialog resource name
IDD_SDKINFORMATION_DIALOG

Resource Yiew - SDKInformation
=54 SDKInformation
= SDKInformation.rc
=1 Dialog
#-_J Icon
#-{ ] Version
[+ SDKInformationppe.rc

t;@Resmm:e View gj Solution Explorer e Properties

The resource editor appears in the right pane.
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Step 3: From the Toolbox, drag a Button control onto the form

Toolbox
= Dialog Editor
R Pointer

I (3 Button

[X| Check Box

ab| Edit Control
Combo Box

=H List Box

[*] Group Box

(¢ Radio Button

Az Static Text

2! Picture Control
[ Horizontal Scroll Bar
B Vertical Scroll Bar
= Slider Control

{‘_‘.'5 Server Explorer i'}’(‘

&
&

ﬁlﬁormﬁon.rc...
Yy =

L

v

Toolbox |

- Dialog*

Ll

B SDKInformation

4

1 "

TODO: Flace dialog contiols hee.

\ |
Bl e nltitiiEmch o B

Step 4: Right-click the Button control, and then click Properties

‘: TODO: Place dislog contuol

WP-5000-CE7 (WinCE7 Based) Series User Manual
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Delete

Add Event Handler...
Insert ActiveX Control...
Add Class...

Add Variable...

Size to Content

Check Mnemonics
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Step 5: In the Properties window, type Check the SDK version, and press ENTER to set the Text
property

Properties _________________®

IDC_BUTTON1 (Button Control) ICeButtonEditor +
e
= f'=‘gv;,»r-'1: ACE Al
Caption Check the SDK version
Client Ed ge False
Horizontal &lignment Defanlt =
Modal Frame False
Multiline Fals
Notify False
bl . ) v
Calition N ' '
Specifies the text displayed by the control.
@Res::nm:é TView fp?ﬁ‘-tiluti-:u‘i Explorer {ﬁPmperﬁes |
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4.5.5. Add the Event Handling for the Control

You have finished the design stage of your application and are at the point when you can start

adding some code to provide the program's functionality.

Step 1: Double-click the button on the form

SDKInformation.rc.. 332 (£H)] - Dialog* = x

[l---luu:-l---nl:---I--uul-

SDKInformation @

L] ] L]
m| Check the SDK version ]l
| [] u

TODO: Flace dialog contiols heye.
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Step 2: Inserting the following code

char sdk_version[32];

TCHAR buf[32];
pac_GetSDKVersion(sdk_version);
pac_AnsiToWideString(sdk_version, buf);
MessageBox(buf,0,MB_OK);

pvold CEDEInformationlle: :OnEnC]ickedButtonl)

1
FOTODD: Add wour control notification handler code here
char zdk_version[32];
TCHAR hof[32];
pac_GetilEVersion(=dk _version);
pac_AnziToWidestring(sdk_version, buf);
MezsageBox{buf 0 ,MB_0K);

h

Step 3: Inserting the following code into the header area

#include “PACSDK.h”

#include "stdafx . h"

#include "SDEInformation.h"
#include "SDKInformationDlg .h"
#1nclude "PACSDE _H"
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4.5.6. Upload the Application to WinPAC

WinPAC supports FTP server service. You can upload files to WinPAC or download files from a

public FTP server.

— 40—

RELSELAR 0 0,0 00, 0 000 0 2 20 )

Step 1: On the Build menu, click Build SDKInformation

File Edit Yiew Project [Build | Debug Tools Test Window Help

=5 DBuild Solution Ctri+Shift+B
Rebuild Solution
Deploy Solution
Clean Solution

[%¥] Build SDKInformation
Rebuild SDKInformation
Deploy SDKInformation
Clean SDKInformation
Project Only >
Batch Budd...
Configuration Manager...

% Compile Ctl+F7

WP-5000-CE7 (WinCE7 Based) Series User Manual version 1.1.2 Page: 116

Copyright © 2018 ICP DAS Co., Ltd. All Rights Reserved. E-mail: service@icpdas.com



Step 2: Open the browser and type the IP address of WinPAC

Step 3: Upload the SDKinformation.exe application to WinPAC

| File Edit View Go |
@ > Fii=R

-

SDKInformati
on

WP-5000-CE7 (WinCE7 Based) Series User Manual version 1.1.2 Page: 117

Copyright © 2018 ICP DAS Co., Ltd. All Rights Reserved. E-mail: service@icpdas.com



4.5.7. Execute the Application on WinPAC

After uploading the application to WinPAC, you can just double-click it on WinPAC to execute it.

]

EDKInformati:
ooneRe
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5. APIs and Samples

This chapter provides a brief overview of PAC APIs and samples that have been designed for
WinPAC.

ICP DAS provides a set of samples in different programming languages. You can examine the
sample codes, which includes numerous comments, to familiarize yourself with the PAC APIs. This

will allow developing your own applications quickly by modifying these demo programs.

For full usage information regarding the description, prototype and the arguments of the functions,
please refer to the “PAC Standard APl Manual”

E PAC Standard AFI Manwal 1.1.1 pdf - Adobe Acrobat Pro

HWFEE RBE WEF) REW) HEAH __.
Re- | DESPPR| e RB i - |
) @) [+ Jrsos | [N O | (= @) (a5 (-] | [ B TH %E #8
L e= M) 2. PAC API Functions 5
I:P B2 [T 3 |- =5
‘ - =P 2.1, System Information ART 2 ﬁ @
4 Ly B (R TERED 4 =[P 2.1, Syster Information AFT A

[P pac_cetRotaryD
éﬁ' EF 2.1.3. pac_GetSerialNumber E 2.1.1. pac_GeNDduler\]ame

[P 21.4. pac_cetSOKversion

[P 2.1.5. pac_changesiot E paE_GetRDtar':.fID

EFZl.ﬁ. ac_CheckSDKVersion .

Poir anodulemm [P 2.1.3. pac_cetserialMumber

gig pa°—§9$5V§;§°“ [P 214 pac_GetsSokyersion

L9, pac_Gelviad Iress

[P 2110, pac_Remoot l:F 2.1.5. pac_tChangeSiot

[P 21,11, Pac_GetcPUversi

Pzl F:E_E;b‘eﬁzrm l:P 2.1.6. pac_checkSDK\ersion

[P 2.1.13. Pac_EnableLEDs .

[P 2.1.14. pac_BackwardCompatinls E 217 FIEIE_MDdUlEE}{lStS

52‘1.15. pac_GetEbootyersion E 2.1.8. paE_GetOSVEr5|Dn

2.1.16. pac_GetComMapping

[P 2.1.17. pac_cetModuleType I:F 2.1.9, pac_GetMac.ﬁ.ddress

[Pa11s pac_GetPachetyersion I:F

[F 2.1.19, pac_PuzzerBeep =2 2'1'10' [:IEIE_REEICIDt

[P 2.1.11. Pac_GetCPUversion =

[P 2.1.12. Pac_EnablelED

[P 2.1.13. Pac_EnableLEDs

I:P 2.1.14, pac_BackwardCompatible
l:F 2.1.15. pac_GetEbootyersion

l:P 2.1.16, pac_GetComMapping

[P 2117 pac_GetvioduleType

[P 2.1.18. pac_GetPachetversion

I:P 2.1.19, pac_BuzzerBeep
(|
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5.1. PAC Standard APIs

The diagram below shows the set of each system operation API provided in the PACSDK.

l [ [ » System Information » Watchdog
[ [ » Backplane Access » UART
» Backlight » Registry
» Interrupt » Buzzer
» Memory Access » LED

System Operation

3

S

.

)

B
vy

L RENERRERE ]
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5.1.1. VB.NET Samples for PAC Standard APIs

The PAC SDK includes the following samples that demonstrate the use of the PAC Standard APIs in

a VB.NET language environment. The following samples can be found on the CD that was provided

with the package or by downloading the latest version from ICP DAS web site.

For VB.NET applications, these demo programs can be obtained from:
CD:\wp-5231\Demo\PAC\Vb.net\Standard\
http://ftp.icpdas.com/pub/cd/winpac am335x/wp-5231/demo/pac/vb.net/standard/

Folder

buzzer

Demo

buzzer

Explanation

Shows how to make a simple buzzer beep.

Devicelnformation

Devicelnformation

Retrieves information about the OS version,
CPU version, SDK version, etc.

GetRotarylD

GetRotarylD

Retrieves information about the

status of the rotary switch

Shows how to read/write data

nt

Memory Memory values from/to the EEPROM or
the backplane of the SRAM
. MicroSD_Manageme i
MicroSD Shows how to manage the microSD

VB_UI_Call_VC_Realti

Writes the managed cod for the rich graphical

user interface that does not require true

me real-time
RealTimeTest
performance
Shows how to use the function of JIT compiler
VBOnly
and garbage collector
Shows how to read/write data
Registry Registry
values from/to the registry
Shows how to read the name of a
UART UART
local I/O modules via a UART
Displays information about how to
WatchDog WatchDog

operate the watchdog
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http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/demo/pac/vb.net/standard/

5.1.2. C# Samples for PAC Standard APIs

The PAC SDK includes the following samples that demonstrate the use of the PAC Standard APIs in

a C# language environment. The following samples can be found on the CD that was provided with

the package or by downloading the latest version from ICP DAS web site.

For C# applications, these demo programs can be obtained from:
CD:\wp-5231\Demo\PAC\C#\Standard\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/demo/pac/c%23/standard/

Folder

buzzer

Demo

buzzer

Explanation

Shows how to make a simple buzzer beep.

Devicelnformation

Devicelnformation

Retrieves information about the OS version,
CPU version, SDK version, etc.

GetRotarylD

GetRotarylD

Retrieves information about the

status of the rotary switch

Shows how to read/write data

t

Memory Memory values from/to the EEPROM or
the backplane of the SRAM
i MicroSD_Managemen i
MicroSD Shows how to manage the microSD

CSharp_Ul_call_ VC_R

Writes the managed cod for the rich graphical

user interface that does not require true

ealtime real-time
RealTimeTest
performance
Shows how to use the function of JIT compiler
CSharpOnly
and garbage collector
Shows how to read/write data
Registry Registry
values from/to the registry
Shows how to read the name of a
UART UART
local I/O modules via a UART
Displays information about how to
WatchDog WatchDog

operate the watchdog
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http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/demo/pac/c%23/standard/

5.1.3. Visual C++ Samples for PAC Standard APIs

The PAC SDK includes the following samples that demonstrate the use of the PAC Standard APIs in
a Visual C++ language environment. The following samples can be found on the CD that was
provided with the package or by downloading the latest version from ICP DAS web site.

For Visual C++ applications, these demo programs can be obtained from:
CD:\wp-5231\Demo\PAC\Vc2008\Standard\
http://ftp.icpdas.com/pub/cd/winpac am335x/wp-5231/demo/pac/vc2008/standard/

Folder Demo Explanation
buzzer buzzer Shows how to make a simple buzzer beep.
) ) ] ) Retrieves information about the OS
Devicelnformation Devicelnformation . ) )
version, CPU version, SDK version, etc.
Retrieves information about the
GetRotarylD GetRotarylD
status of the rotary switch
Shows how to read/write data
Memory Memory values from/to the EEPROM or
the backplane of the SRAM
MultiRT MultiRT Shows how to manage the microSD
Writes the managed cod for the rich
graphical user interface that does not
RealTimeTest RealTimeTest . .
require true real-time
performance
Shows how to read/write data
Registry Registry
values from/to the registry
Shows how to read the name of a
UART UART
local I/O modules via a UART
Displays information about how to
WatchDog WatchDog
operate the watchdog
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5.2. PACIO APis

The diagram below shows the types of the PAC 10 APIs provided in the PACSDK or the specified
SDK.

For more information about the APIs and samples provided by the expansion I/O modules, please
refer to chapter 6. 1/0 Modules and SDK Selection.
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5.2.1. VB.NET Samples for PAC Standard APIs

The PAC SDK includes the following samples that demonstrate the use of the PAC IO APIs in a
VB.NET language environment. The following samples can be found on the CD that was provided

with the package or by downloading the latest version from ICP DAS web site.
For VB.NET applications, these demo programs can be obtained from:
CD:\wp-5231\Demo\PAC\Vb.net\IO\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/demo/pac/vb.net/io/

Folder Explanation

XV107_Modbus_RTU_Master Shows how to use the XV107 module
XVBoard/XV107 |
_VB_demo of the XV-board
Remote For full details regarding the remote I/0O modules and its demos,
(1-7000 or I-87K please refer to:
modules in RU-87Pn I/O | http://ftp.icpdas.com/pub/cd/winpac am335x/wp-5231/demo/pac/
unit) applicabled demo for 7k module.pdf
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http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/demo/pac/vb.net/io/
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/demo/pac/applicabled_demo_for_7k_module.pdf
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/demo/pac/applicabled_demo_for_7k_module.pdf

5.2.2. C# Samples for PAC Standard APIs

The PAC SDK includes the following samples that demonstrate the use of the PAC 10 APIs in a C#

language environment. The following samples can be found on the CD that was provided with the

package or by downloading the latest version from ICP DAS web site.

For C# applications, these demo programs can be obtained from:

CD:\wp-5231\Demo\PAC\C#\IO\

http://ftp.icpdas.com/pub/cd/winpac am335x/wp-5231/demo/pac/c%23/io/

Folder

Explanation

ModbusRTU_Master_Conso

Shows how to use the XV107 module

please refer to:
(I-7000 or I-87K modules

le of the XV-board in console mode
XVBoard/XV107
XV107_Modbus RTU_Mast | Shows how to use the XV107 module
er_demo of the XV-board
For full details regarding the remote I/O modules and its demos,
Remote

http://ftp.icpdas.com/pub/cd/winpac am335x/wp-5231/demo/pac

in RU-87Pn I/0 unit)

/applicabled demo for 7k module.pdf
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http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/demo/pac/c%23/io/
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/demo/pac/applicabled_demo_for_7k_module.pdf
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/demo/pac/applicabled_demo_for_7k_module.pdf

5.2.3. Visual C++ Samples for PAC Standard APIs

The PAC SDK includes the following samples that demonstrate the use of the PAC Standard APIs in
a Visual C++ language environment. The following samples can be found on the CD that was
provided with the package or by downloading the latest version from ICP DAS web site.

For Visual C++ applications, these demo programs can be obtained from:
CD:\wp-5231\Demo\PAC\Vc2008\I0\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/demo/pac/vc2008/io/

Folder Demo Explanation
Remote For full details regarding the remote I/O modules and its demos,
(1-7000 or I-87K please refer to:
modules in RU-87Pn I/O | http://ftp.icpdas.com/pub/cd/winpac am335x/wp-5231/demo/pac/
unit) applicabled demo for 7k module.pdf
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http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/demo/pac/vc2008/io/
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/demo/pac/applicabled_demo_for_7k_module.pdf
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/demo/pac/applicabled_demo_for_7k_module.pdf

6. 1/O Modules and SDK Selection

This chapter describes how to select a suitable I/O expansion module and the corresponding SDK

library to be used for developing programs on WinPAC series devices.

Selecting an SDK Library for 1/O Expansion

0 < Ethernet

ET-7000

RS-232/RS-485

RU-87Pn

M-7000
[-7000
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0 Local I/0 Module (XV-Board)

There are more than 8 XV-Board available for expanding the function of the WP-5000-CE7
The following table shows the appropriate SDK library to be used for I/0

modules.

Module Native SDK .NET CF SDK

XV-Board Modbus Demo Modbus Demo

For more detailed information about these support modules, please refer to

http://www.icpdas.com/root/product/solutions/hmi touch monitor/touchpad/xv-board selectio

n.html

g RS-485 (1-7000 series and M-7000 series)

[-7000, M-7000, RU-87Pn and high profile 1-87K series modules connect to WP-5000-CE7 via a
twisted-pair, multi-drop, 2-wire RS-485 network.

» 1-7000 series 1/0 modules

Native SDK .NET CF SDK
I-7000 series PACSDK.dII PACNET.dII
I-7000 series with 1-7088 (D) PACSDK_PWM.dII PACNET.dII

For full details regarding 1-7000 series I/0 modules and its demos, please refer to:
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/demo/pac/applicabled demo for 7k m

odule.pdf
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http://www.icpdas.com/root/product/solutions/hmi_touch_monitor/touchpad/xv-board_selection.html
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/demo/pac/applicabled_demo_for_7k_module.pdf
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/demo/pac/applicabled_demo_for_7k_module.pdf

» M-7000 series I/0O modules

Module Native SDK .NET CF SDK

M-7000 series Modbus Demo Modbus Demo

For more detailed information about M-7000 series modules using Modbus protocol and its
demos, please refer to:
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/demo/nmodbus/

» RU-87Pn + I-87K series I/O modules

Module Native SDK .NET CF SDK

RU-87Pn + 1-87K PACSDK.II PACNET.dII

»  Other specified 1/0

Module Native SDK .NET CF SDK

1-7088W | PACSDK_PWM.dII PACNET.dI|

@ Ethernet (ET-7000 series and 1-8KE4/8-MTCP)

The Ethernet I/0O devices available include ET-7000 and |-8KE4/8-MTCP, and support the
Modbus/TCP communication protocol.

Module Native SDK .NET CF SDK
ET-7000 Modbus Demo Modbus Demo
I-8KE4/8-MTCP Modbus Demo Modbus Demo

For more detailed information about ET-7000 and I-8KE4/8-MTCP series modules using Modbus
protocol and its demos, please refer to:
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/demo/nmodbus/
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7. WP-5000-CE7 Updates

This chapter provides information of the WinPAC OS and SDKs, and a guided tour that
demonstrates the steps needed to update the WinPAC OS and SDKs.

ICP DAS will continue to add additional features to WinPAC SDK and OS in the future, so we advise
you to periodically check the ICP DAS web site for the latest updates.

Both the files of OS updates and SDK updates can be found on the CD that was provided with the

package or by downloading the latest version from ICP DAS web site.

CD:\wp-5231\

http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/

update_from_file

update_from_Micro_SD

> The files of OS updates

PlatformSDK
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7.1. OS Updates

OS updates are part of the WP-5000-CE7 updates services to provide additional and more efficient
features and functionality for WP-5000-CE7 operating system.

The updates files of OS image can be found separately on the CD that was provided with the

package or by downloading the latest version from ICP DAS web site.

CD:\wp-5231\0S_Image\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/os_image/

update_from_Eshell_or_Micro_SD

update_from_file

There are two ways to update the OS:

0OS image

update_from_Eshell_
or_Micro_SD

update_from _file

ey e —

1. Update from eshell (Please refer to section 7.1.1)
(We recommend that you use this one for more quicker and easier to update)

2. Update from micro_SD (Please refer to section 7.1.2)
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7.1.1. OS Updates using Eshell

By default, the OS updates via LAN. Therefore, to update the
OS image, make sure LAN is connected to the PC.

Step 1: Get the latest version of the installation package file and then unzip
it

The latest version of the installation package file can be found from
ICP DAS web site.
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/os _image
/update from eshell or micro sd\

Step 2: Run the registry clear.exe ' N l
The registry.exe can be found on the CD that was \ \
provided with the package or by downloading the 2
latest version from ICP DAS web site. Run tlhe

ist :

CD:\wp-5231\PC_Tools\Eshell gy asanese
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/pc tools/
eshell

Step 3: Place the rotary switch in position 3, OS update mode
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Step 4: Run the ESHELL.exe, and then restart the WP-5000-CE7

The ESHELL.exe can be found on the CD that was provided with the
package or by downloading the latest version from ICP DAS web site.
CD:\wp-5231\PC_Tools\Eshell ESHELL
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/pc_tools/

eshell

Step 5: Select the device which you want to update the OS image, and then click OK

Select the device name which you want to update the OS image from the list.

Select Device El

Entet Device M ame: 0K

[WINPAC270_535

Cancel
Or Sedect From the List

Reset devices to
automatically put
names on the
list.

Step 6: Select the latest version of the OS image file

=~ o« B efEr

Look, in: | |75 WPS523x_20140821_Ver.1.0.0.4_ml

&

it Windaws O Dabagg Skl - WF_LLEM SARATAd_Ti Wl Dl calerp P00 _ca M0 _image'vy 20wl [ ||

-
| | | | #|@

Desklnp F_SSAPE | BEeTiaader BErRlis 1,8, §F; 107,050, MRS BERETF Ao

Sownlesding “ViRE ol TV aPED apdes’ v - TR ot INEE_ i megeiep - Pluiapdate_Fron [vbel1%en8

pleplag U6 Lasge o OF_SW0E ...
EonnriLing te oF_sbadl wning Diherast, .,

My Documents

My Compater

My Negt‘wk File name: WE BIN
Files of type: NE Imags
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Step 7: Once the procedure is completed, the “Warning !” dialog box will appear as below
shown, then turn the rotary switch in position 0, normal mode

Warning

"'_..‘ Reboot this device right nowy |
L Flease turn the rotary switch to 0 - normal

Step 8: Click the OK button

YWarning

'."_n., Reboot this device right now ! _
L Please turn the rotary switch to 0 - normal

Step 9: Check the OS version

Start the PAC Utility, and then select the “Device Information”

&

Double-click the
PAC Utility shortcut

tab to check the current OS version.

5

General I Display I\\ pig | Netwark |De\-'|ce1nf0rmatlon| Auto Execution IRDtary Execution I
o

setli [ | CPU Type: [wPs23x |
Sit2: [ ] SerialMumber: |01-4g-2C-1F-16-00-00-20 |
Slot 3: I:I Backplane Yersion: |NfA |
Slot 4: I:I CPL Yersion: |Nf,q |
Slot 5: I:I 05 Wersion: |1001 |
Slot 6: I:I MET CF Yersian: |3.5.?338.DD |
Slat 7 |:| SQL CE Yersion: | |

PACSDE YYersion: |4.3.D.D |
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7.1.2. OS Updates using micro_SD

The microSD card can be used to reinstall the WP-5000-CE7 OS image to factory default settings in
the event of the WP-5000-CE7 failure.

Step 1: Get the latest version of the installation package file, then unzip the file, and then copy

them to microSD card

The latest version of the installation package file can be found from ICP DAS web site.
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/os image/update from eshell

or micro sd\

W WP523x 20140821 _Ver 1.0.0.4_ml

File Edit Wiew Favorites Tools Help

OBack T s 'ﬂ‘ 7’ ! Search Folders

Address |3 C:\opdate_from_Eshell_or_bicro_3SD\WE523x_2014082 A

:] [ :I EBOOTSD.nk0 Puoee
| T3 | NED HE
m'S'J

4 ZLDRNAND.nb0 [ | XLDRSDnb0
NED &% NED 83

Step 2: Plug the microSD card into microSD slot

iCrO
mS')

Adapter
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Step 4: Reboot the WP-5000-CE7

Step 5: Wait a few minutes for the following desktop to be displayed

Step 6: Turn the rotary switch in position 0, normal mode

Step 7: Reboot the WP-5000-CE7

Step 8: Check the OS version

@

Double-click the
PAC Utility shortcut

Start the PAC Utility, and then select the “Device Information”

tab to check the current OS version.

General I Display Il

setli [ | CPU Type: [wPs23x |
Sit2: [ ] SerialMumber: [01-88-2c-1F-1600-0020 |
Slot 3: I:I Backplane Yersion: |NfA |
Slot 4; |:| CPL Wersion: |NfA |
Slot 5: I:I 035 Wergion: |1001 |
Seté: [ | METCFVerson:  [a.5.73sao0 |
Slat 7 |:| SQL CE Yersion: | |

PACSDK Yersion: |4,3,g,g |
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7.2. SDK Updates

SDK updates are part of the WP-5000-CE7 updates services to provide additional and more
efficient features and functionality for WP-5000-CE7 operating system.

The updates files of SDK files can be found separately on the CD that was provided with the
package or by downloading the latest version from ICP DAS web site.

CD:\wp-5231\SDK\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/sdk/

.
— .
— .
— .
—
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7.2.1. SDK Updates for VB.NET or C#

You can just change the old one with a new one.

Step 1: Get the latest version of the PACNET.dII

The latest version of the PACNET. dll can be obtained from ICP DAS web site.
http://ftp.icpdas.com/pub/cd/winpac am335x/wp-5231/sdk/pacnet/

Step 2: Copy the PACNET.dII file to PC and WP-5000-CE7

The DLL files on PC are located at anywhere only the solution can reference it.
The DLL files on WP-5000-CE7 are located at the same directory as the .exe file.
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7.2.2. SDK Updates for Visual C++

You can just change the old one with a new one.

Step 1: Get the latest version of the VC++ components

The latest version of the VC++ components can be obtained from:
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/sdk/pacsdk/

Step 2: Copy the latest version of header files and libraries to Host PC

The header files are located at:

C:\Program Files\Windows CE Tools\SDKs\AM335x_WINCE7_SDK\Include\Armv4i
The libraries are located at:

C:\Program Files\Windows CE Tools\SDKs\AM335x_WINCE7_SDK\Lib\ARMv4|

Step 3: Copy the latest version of DLL files to WinPAC

The DLL files are located at:
\System_Disk\ICPDAS\System
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Tips — How to

This chapter provides tips and a guided tour on using and maintaining the WinPAC.
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A. How to Online Debug the WP-5000-CE7 Program

Here are step by step instructions on how to online debug the WP-5000-CE7 program.

Tips & Warnings

A\

Before starting online debug the WP-5000-CE7 program, make sure that the
WP-5000-CE7 SDK has been installed correctly.

For more information on how to install the WP-5000-CE7 SDK, please refer to 4.2.
Installing WP-5000-CE7 SDK.

Step 1: Copy the following files to the \System_Disk\icpdas\system on the WP-5000-CE7

By default, these files are located on the development computer at C:\Program
Files\Common Files\Microsoft Shared\CoreCon\1.0\Target\wce400\<CPU>.

clientshutdown.exe

CMAccept.exe

ConmanClient2.exe

eDbgTL.dll

TcpConnectionA.dll

Step 2: Run the ConmanClient2.exe and then CMAccept.exe on the WP-5000-CE7

rnfcB0ipn

pacnet

4]

atlan

]

rnfcB0kar

)

rmfcS0ita

]

pacsdk

[I]A;JdrESS | WSystem_Diskicpdassystemn

bie

autainit

]

rnfc30u

)

mfc2dipn

|

pacsdk_prwm

|

rmfcB0chs

]

rnfcB0ud

)

rnfcS0kar

4]

eb0bgTL

]

mfc20cht

]

mfc90chs

<)

mifcS0Lu

3]

TecpCanne... clientshist,,,

|

rnfcB0deu

mifcS0ud

iy
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j
rnﬁ:ElDfreE
S

msycr90 ‘},)
)
1
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Step 3: On the Tools menu, click the Options...

File Edit View Project Build Debug Test Window Help

15092001~ 1= I T R

: AM335x WINCE7_SDK AF ~ | 85 @ | 4%

Attach to Process...

Ctrl+Alt+P

Device Security Manager...
Connect to Device...

evic

External Tools...

Options...

Step 4: In the left pane, expand Device Tools node and select Devices

Import and Export Settings..

Step 5: In the Show devices for platform:, select AM335x_WINCE7_SDK and then click Properties

Options

Environment

devices for platform:

Projects and Solutions
Source Control

| AM335x_WINCE7_SDK

Text Editor
Database Tools
Debugging
Device Tools
General
Devices
Form Factors
HTML Designer
Office Tools
Test Toals
Text Templating
Windows Forms Designer

AM335 WINCE7_SDK ARMYY Device

Workflow Designer
Default device:

AM335x_WINCE7_SDK ARMV7 Device
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Step 6: Click the Configure...

AM335x_WINCE7_SDK ARMV7 Device Properties

-

0 e

Default output location on device:

Transport: /

\I

|TCP Connect Transport ('| ‘ Configure.. ‘ >
Bootstrapper: \ /
|ActiveS}rnc Startup Provider 6 | Configure..
Detect when device is disconnected

OK ‘ ‘ Cancel

Step 7: Select the Use specific IP address:, and then type the IP address of WP-5000-CE7

Configure TCP/IP Transport

=x=)

"] Use fixed port number: 5655

Device IP address

@ Use specific IP address:

10.1.0.96] / v
OK J ‘ Cancel
-
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Step 8: Click the OK, and then click OK to end the dialog

.
AM335x_WINCE7_SDK ARMV7 Device Properties

— e e

Default output location on device:

Transport:

[TCP Connect Transport i l l Configure...
Bootstrapper:

[ActiveSync Startup Provider '] ‘ Configure..

Detect when device is disconnected

> Environment

> Projects and Solutions
> Source Control

> Text Editor

> Database Tools

> Debugging

a Device Tools

General
| Devices|
Form Factors
> HTML Designer
> Office Tools
> Test Tools
» Text Templating
> Windows Forms Designer
> Workflow Designer

Show devices for platform:

IAM335)(_WINCE?_S DK

)

Devices:

AM335x_WINCE7_SDK ARMV7 Device

Default device:

AM335x_WINCE7_SDK ARMV7 Device

Save As..
Rename...
Delete

Properties...

1
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Step 9: On the Tools menu, click the Connect to Device...

File Edit View Project Build Debug |Tools | Test Window Help
5% | Attach to Process... Ctrl+Alt+P

ce Security Manager...

Connect to Device...

Device Emulator Manager...

Connect to Database...

Code Snippets Manager.. Ctrl+K, Ctrl+B

g™
:! Connect to Server...
@

L

Step 10: Wait for the connection to be established

Connecting..

.“g_
To 'AM335x_WINCE7_SDK ARMV7 Device'
Connection succeeded.

Tips & Warnings

e If the connection fails, as shown below, please repeat the step 2 to step 9 to try it
again.

Connecting...

To 'AM335x_ WINCE7_SDK ARMVT Device'

Connection failed. ActiveSync bootstrap initialization
failed.
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B. How to Automatically Synchronize WinPAC Clock with
an Internet Time Server

You can synchronize your WinPAC clock with an Internet time server.

If synchronization is enabled, the WinPAC clock is synchronized with an Internet time server.

Step 1: Double-click the PAC Utility on the desktop

&

Double-click the
PAC Utility shortcut

Step 2: On the General tab, press Configure button

PAC Utility [1.2.0.6] ! E

Generall Display IIP Config INetWDrk IDevice Information If-'«ub: Execution I Rotary Execution |

Welcome to use PAC Liility
This tool will help you easy 1o
use PAC CE series,

Task Bar setting:
[ &uto Hide

[] &bways On Top

HIYE Feqgistry:

©
O v
Backplane Battery [ ] Enable &utorun in plugging USE Disk
Batteryl : [] Enable &utorun in plugging Micra SO
Configure the synchronization with a time server | Configure
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Step 3: Select the domain name from the Server drop-down list, and then enter a value in the

Autoupdate Frequency field

Step 4: Check the Automatically synchronize

with an internet time server check box

Step 5: On the File menu, click Save and Reboot

Internet Time 1.0.0.1 _|
Stepl: Server: Imck.usnu.naw.mil El

StepZ: Autoupdate Frequency: I:l rrinUte
Step3:

[ Automatically synchranize with an internet time server

| Update Mow

Save and Reboot
Reboot
Restore Utility Default Settings
Exit

Step 6: The WinPAC will automatically synchronize with an internet time server regularly

Step 7: Click the Update Now button to synchronize WinPAC clock immediately

Internet Time 1.0.0.1 _|
Stepl: Server: |'o:u:l<.usnn:u.naw.mil El

Step2: Autoupdate Frequency: | | minute
Step3:

|:| Autornatically synchronize with an internet tirme server

| Update Mow
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C. How to use User Account Control in WinPAC
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C.1. How to Create an User Account

Here are step by step instructions on how to add a user account.

Step 1: Double-click the PAC Utility on the desktop

Step 2: On the Login tab of the Network tab, click Login tab, type the User Name and Password,
and then click Add button

PAC Utility [1.2.2.0] [_|
File Help

General l General2 l Display ] IP Config | Metwark lDevice Infarmation ] Ao Execution l Rotary Exe »

Access | Login l

Lser Mame Password

ficPoas | || ad Delete

User name | Password |

Step 3: The user has been added to the allowed under the remote login and included in the

following list

PAC Utility [1.2.2.0] !
File Help

General l General2 l Display l IP Config | Network lDevice Infor ration ] Auto Execution l Rotary Exe »

&ccess | Login l Page: 150

w

-

C User Name Password e@icpdas.com
ficr D25 | | add || Deket

User name | Password




Step 4: On the File menu, click Save and Reboot for changes to take effect

Save and Reboot

Restore Utiity Default Settings
Exit
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C.2. How to Use Telnet to remote login the WinPAC from
PC

Here are step by step instructions on how to use telnet to remote login the WinPAC from PC.

Step 1: On the PC, open a MS-DOS command prompt

S, SIPSPWL R VISV T W , Ty RSPy

- W . S

&\~ Windows Catalog g
<

% windows Update 3

!
m e ' ﬁ

;- Documents »
B & ' Type the s document, or
4 Interns’ =soUrce; ara—rrraows Wil open it For you,
Help“and Support
Open: | Ei v

[ OK ][ Cancel ][ Browse... ]

Step 2: At the command prompt, type “telnet (IP address)”

o CAWINDOWS system 32w md exe

C:“Documents and Settings“Windows>telnet 18.1.8.31
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Step 3: The connection has been set up, and then type the name and password

¢t Telmet 10.1.0.31

llelcome to the Windows CE Telnet Service on Compact

login: ICPDAS
Pazsword:

Step 4: The remote login has been completed

c Telmet 1001.0.31

Wlelcome to the Windows CE Telnet Service on Compact

login: ICPDAS
Paszword:
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C.3. How to Remove a User Account from the Login List

Here are step by step instructions on how to remote the user from the login list.

Step 1: Click a user from the list which you want to remove, and the user will display in the field,

and then press Delete to delete the user from the login list

PAC Utility [1.2.2.0] !

File Help

[General IGeneraI2 IDispIa\; IIF' Config | Metwork |Device Infor mation IAuh: Execution IRotary Exg 1| P

[ﬁccess| Login |

User Marme Password
fice Das | [r==r | Add | Delete

User name | Password

Step 2: On the File menu, click Save and Reboot for changes to take effect

Save and Reboot

Reboot
Restore Liility Default Settings

Exit
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D. How to change the battery

RTC is retained by a Li-ion battery, which can supply continuous power for 10 years. The battery
design has the added function of preventing data from being lost while replacing the battery. The
following figures show the location of the battery installed in the WinPAC CPU board.

WP-5231M-CE7/WP-5231PM-3GWA-CE7
WP-5231PM-4GC-CE7/WP-5231PM-4GE-CE7

WP-5231-CE7

Checking the current battery power

1. Runthe PAC utility and check the Battery 1 fields that display the current status. Refer to
Section 3.1 PAC utility “General” for more details. If the power level is low that the battery
should be replaced.

2. When programming this, call the pac_GetBatteryLevel() API function in the PACSDK.dII to
check whether the battery power is low. When the power of the battery is low, it’s
recommended that the battery is replaced immediately, otherwise the RTC time will be reset.
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Replacing the battery

Power off the WinPAC device.

Remove the CPU board.

Remove the battery that is running low on power from the battery holder in CPU board.
Insert a new battery.

Set the RTC time.

AR S

Tips & Warnings

Risk of Explosion if Battery is replaced by an Incorrect Type. Dispose of Used Batteries
According to the Instructions."

Ordering information

Battery type: BR1632 (Part number is 2LB010 for ICP DAS)

For more detailed information, contact your local sales office or distributor.
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E. How to Using the Practical Functions of the 3G/4G 1/0
Module

The WP-5231PM-3GWA, WP-5213PM-4GE-CE-CE7/WP-5231PM-4GC-CE7 built-in Mobile network
modem that utilize the 3G/4G network to implement SMS and GPRS connection to send and

receive functions.
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E.1. How to Auto Dial 3G/4G GPRS network and redial
when the network disconnected

The AutoDialer allows user to automatically dial GRPS network after boot.

When the GRPS network disconnect the AutoDialer will automatically re-dial Internet access.

Tips & Warnings

Before installing the SIM card, please cancel the PIN lock function of SIM card;
otherwise you will not be able to dial the Internet

The demos can be found on the CD that was provided with the package or by downloading the
latest version from ICP DAS web site.

CD:\WinPAC_AM335x\wp-5231\demo\3g_modem\autodialer\
http://ftp.icpdas.com/pub/cd/winpac am335x/wp-5231/demo/3g modem/autodialer/

The description of the demo can be found by downloading the latest version from ICP DAS web
site.

http://ftp.icpdas.com/pub/cd/winpac am335x/wp-5231/document/faqg/development/
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E.2. How to Use the SMS Function and Get the GPS Data

The 3G/4G modem allows the user to use the SMS function and get the GPS data.

The APl manual can be found by downloading the latest version from ICP DAS web site.

http://ftp.icpdas.com/pub/cd/winpac am335x/wp-5231/demo/3g modem/3g modem sms de

mo/gsm lib manual v1.0.1.pdf

The demos can be found on the CD that was provided with the package or by downloading the
latest version from ICP DAS web site.

CD:\WinPAC_AM335x\Wp-5231\demo\3g_modem \3G_modem_SMS_Demo\
http://ftp.icpdas.com/pub/cd/winpac am335x/wp-5231/demo/3g modem/3g modem sms de

mo

The description of the demo can be found by downloading the latest version from ICP DAS web
site.

http://ftp.icpdas.com/pub/cd/winpac am335x/wp-5231/document/faq/development/
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E.3. How to Synchronize the System Time by GPS Data

The demos can be found on the CD that was provided with the package or by downloading the
latest version from ICP DAS web site.

CD:\WinPAC_AM335x\Wp-5231\demo\3g_modem\gpstimesynchronization\
http://ftp.icpdas.com/pub/cd/winpac am335x/wp-5231/demo/3g modem/gpstimesynchronizati

on

The description of the demo can be found by downloading the latest version from ICP DAS web
site.

http://ftp.icpdas.com/pub/cd/winpac am335x/wp-5231/document/faqg/development/
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F. XV-Board Modules

The XV-board series are for LP-5000, WP-5000-CE7.
One PAC can only plug only one XV-board. The

XV-board series have following common
specification:

e DI channel is dry contact, sink type.

e DO channel is open collector, sink type.

DIO Expansion

DO
Channel Sink/Source Channel Sink/Source
XV107 Source Sink
8 Wet 8
XV107A Sink Source
XV110 16 Dry/Wet Sink/Source - -
XV111 Sink
- 16
XV111A Source

Relay Output Expansion

Relay Output

Channel Sink/Source Channel Type
2 Signal Relay
XV116 5 Wet Sink/Source
4 Power Relay

Multi-Function Expansion

Al AO DI DO
Channel Type Sink/Source Channel Sink/Source
XV308 8 - DI+DO=8 Source Sink
Dry/Wet DI+DO=8
XV310 4 5 4 Sink Source

For more detailed information about these support modules, please refer to

http://www.icpdas.com/root/product/solutions/hmi touch monitor/touchpad/xv-board selectio

n.html
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G. Revision History

This chapter provides revision history information to this document.

The table below shows the revision history.

Revision Description

1.0.0 January 2015 Initial issue

1.0.1 September 2015 | Modified the information about the XV-board installation in section
2.2. Installing the XV-Board.

1.0.2 December 2015 | 1. Modified the product name from WP-5231 to WP-5231-CE7.

2. Modified the CPU specification from AM3354 to Cortex-A8

3. Deleted the product information of WP-5231M-3GWA.
1

1.0.3 March 2016 . Deleted the information about the printer application in Appendix
Al

2. Added the information on how to online debug the WP-5231-CE7
program in Appendix A.1.

1.04 September 2016 | 1. Added the information about the WP-5231PM-3GWA-CE7
specification in section 1.2. Specifications.

2. Added the information about the WP-5231PM-3GWA-CE7
overview, dimension and installation in section 1.3. Overview.

3. Added the information about the WP-5231PM-3GWA-CE7
dimension in section 1.4. Dimensions

4. Added the information about the WP-5231PM-3GWA-CE7
installation in section 2.1.2. WP-5231PM-3GWA-CE7 Installation.

1.1.0 March 2017 1. Added the information about the WP-5231M-CE7 specification in

section 1.2. Specifications.

111 October 2017 | 1. Added the information about the WP-5231PM-4GC-CE7 and

WP-5231PM-4GE-CE7 specification in section 1.2. Specifications.
2. Added the information about the WP-5231PM-4GC-CE7 and
WP-5231PM-4GE-CE7 overview in section 1.3. Overview.

3. Added the information about the WP-5231PM-4GC-CE7 and
WP-5231PM-4GE-CE7 dimension in section 1.4. Dimensions

4. Added the information about the WP-5231PM-4GC-CE7 and
WP-5231PM-4GE-CE7 installation in section 2.1.2.
WP-5231M-CE7/WP-5231PM-3GWA-CE7/ WP-5231PM-4GC-CE7
/WP-5231PM-4GE-CE7 Installation.
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Revision Date Description
1.1.2 April 2018 1. Added the information about how to change the battery in
Appendix D.
2. Added the information about the 3G/4G applications in Appendix
E.
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